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Introduction
Micro Focus proudly introduces AccuRev Version 7.1, helping you unleash the power of software
development teams to deliver superior results.

Highlights of this Release
Highlights of exciting new developments in AccuRev 7.1 are captured here.

Enhanced Filtering in the History Browser
AccuRev 7.1 offers enhanced filtering capabilities in the History Browser to enable you to hone in on the
transaction information that is of interest to you. In previous releases of AccuRev, the History Browser’s
table of transactions could be filtered to display only the transactions performed by a specific user.
AccuRev 7.1 expands upon that, providing filtering by users, groups, and actions.
In the Users filter, you can now elect either to see transactions by all users or to filter by users or groups.

AccuRev groups are displayed at the bottom of the dropdown menu. You can select any one of the groups
in order to see what transactions were executed by members of that group. If you choose “Select Users…”
instead, a dialog will appear and allow you to divide the set of AccuRev users into an Included list (the
users whose transactions will be displayed in the History Browser) and an Excluded list (the users whose
transactions will be hidden from view). Left- and right-arrows move selected users from one table to the
other, and the Swap button performs a quick exchange of the two tables’ contents.
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The new Actions filter in the History Browser allows you to select what types of actions you want to see
listed in the transactions table. Again, you use the arrow buttons to divide the set of action types into an
Included list and an Excluded list and then click on the OK button.
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The tooltips for the Users and Actions filters identify how the history display is currently being filtered.
For example:

As shown in the examples above, the Users and Actions filters can be used in conjunction to focus on
select actions committed by a specific set of users.
A new Clear button resets all the filters located to the left of the button back to their default state:

Note: The Active Transactions default group in the Stream Browser no longer contains a Users filter.
Instead, you can filter active transactions by user via the advanced filters now available in the Active
Transactions tab.

Admin Command Permissions GUI
A new graphical user interface has been implemented to enable the AccuRev administrator to configure
which users are allowed to execute a variety of administrative level commands. Previously, the way to do
this was to write perl script in the server_admin_trig.bat or server_admin_trig.pl files installed in the
<ac-install>/storage/site_slice/triggers directory.
Here is a look at the new GUI:
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This configuration page is accessible from the “Admin” menu underneath the “Security” option. The
“Global Default” Condition allows you to configure admin command permissions for the entire site.
Command permissions can apply to an individual user or to a specific group of users. You can also apply
permissions broadly to the two built-in groups:


anyuser - All users without a password



authuser - All users with a password

In the case that permissions have been configured for both a user directly and a group that the user is a
member of, the permission setting closest to the user is the one that applies. For example, if a user is a
member of the “qa” group and the “qa” group is denied access to the “chstream” command, but the user is
specifically configured to be allowed permission to the “chstream” command, the user’s own permission is
the one that applies.

Configuring a Superuser
In order to set or remove admin command permissions, you must either be a superuser or have been
granted explicit “allow” permission for the “setcmdacl” and “rmcmdacl” commands. To designate a user
as the superuser, the AccuRev administrator must use the maintain utility:
maintain su -a <username>

Changing Command Permissions
To edit command permissions, you must either select one of the existing conditions that you want to edit or
add a new condition. The conditions are either the site-wide “Global Default” command permissions or
command permissions set on a specific stream. Only commands that apply to a stream or stream hierarchy
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can be configured at the stream level. Examples of commands that are configurable by stream are: setting
stream properties, mkstream, and chstream.
Either highlight the condition you want to edit and click the “Change Command Permissions” button,
double-click on the condition, or right-click on the condition and choose the “Change Command
Permissions” context menu option. The following dialog will appear:

Now you need to add the user or group whose command permissions you want to configure. Command
permissions are configured for one single user or one specific group of users at a time. This is similar to
how Windows file permissions can be configured. You can add multiple users to the “Applies To” section
of the dialog, but the “Command Permissions” that you configure apply only to the currently highlighted
user or group:
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Notice that the title of the “Command Permissions” section identifies the user or group whose permissions
are being configured.
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If you add testuser1 to the Applies To section, you can see that the command permissions for “testuser1”
can also be configured now. Once you configure permissions for the desired set of users and groups, click
OK to save your changes.

Stream-Aware Command Permissions
For commands that apply to a stream or stream hierarchy, you can add a new condition for that stream and
configure command permissions that you want to apply to it only. You can also choose to make your
command permission setting inheritable so that it applies to the entire stream hierarchy below the specified
stream. For example, suppose you want to allow users to change the streams in the "development" stream
hierarchy, but you don’t want anyone to change streams above that level. To accomplish this, you could
deny access to chstream in the global default, but set an explicit inheritable "allow" permission for the
chstream command on the “development” stream:
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Removing Command Permissions
To remove a condition entirely (except for the Global Default Condition), highlight the condition and click
the “Remove Command Permissions” button. To remove command permissions for a specific user or
group from a condition, highlight that condition and select “Change Command Permissions”. In the dialog
that pops up, remove the users and groups that you no longer want permissions to be set for.
By default, if no permission is set for a user or any group he is a member of or the built-in group that he is
a member of, the user is implicitly granted "allow" permission for that command.

Push Notifications
In Release 7.1, the AccuRev server generates push notifications for all write operation events. These
notifications are published through the Mosquitto MQTT Broker, which was introduced in AccuRev 6.2
for use with Gated Streams. The notifications are configurable at the server side, consumed by the GUI,
and available to users at the client level via the CLI.

Server
A new setting called NOTIFICATION_LEVEL in the acserver.cnf file configures the type of
notifications that are published.
All notifications are classified into the following four categories:


Streams (e.g., keep, promote, chstream)



AccuWork (e.g., create/edit an issue, cpkadd)



Depot (e.g., mkdepot, mktrig)



Site (e.g., mkuser, chgroup)

# Push notifications, 0=Off, 1=Streams, 2=AccuWork, 4=Depot, 8=Site, 15=All (1+2+4+8)
NOTIFICATION_LEVEL = 1

To specify which notifications get published, add the values for each desired category together. Streams
and AccuWork notifications would be 3, for example; all notifications would be 15. To turn the feature off,
set the notification level to 0.
The default notification level is 1 -- stream-type notifications only.

GUI
The views that a user has open in the GUI can become out-of-date as other AccuRev users execute
operations. In 7.1, the GUI uses the server-generated stream notifications to display “notification badges,”
which give the user a hint that activity has occurred in the stream(s) they are viewing.
The GUI displays notification badges in the tab header of the following types of views:


Stream Browser



History (depot, stream/workspace, transactions)



File Browser

In the screenshot below, the badge indicates that two new transactions have occurred in this Stream
(Workspace) History view.
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Badge notification counts increment for each new applicable transaction that has occurred since the view
was generated or refreshed. Refreshing the view clears the badge (since the view then includes the latest
transactions).
Notification badges are configured via a preference setting. There is one global setting for all types of
views:

CLI
The new trace-event CLI command listens for the server-generated notification events and can print them
to the screen, output them to a log file, or pass the values to a script to take some user-defined action.
trace-event has arguments to filter notifications based on category or notification kind, by depot, stream,
or user. If you specify no arguments, trace-event listens and prints all push notifications generated by the
server.
# accurev trace-event
Trace Event: Connected to server myserver:1883
Trace Event: Subscribing to ‘accurev/info/notifications/+’

Note: Unlike other AccuRev commands, trace-event continues to listen until it is interrupted with a Ctrl+C
or Ctrl+Break signal.
Refer to the CLI User’s Guide for additional details on the command arguments and examples.
Site administrators can control access to the trace-event command through the new Admin Command
Permissions GUI or through the traditional server_admin_trig trigger. Users without access to the traceevent command will see the error message “You are not authorized to perform this operation.”
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License Manager
AccuRev 7.0 replaced the Reprise RLM license manager with a new built-in license manager. The new
license manager supports standard and flexible licenses. The license file is now named aclicense.txt
instead of accurev.lic.
Note: In order to upgrade from a pre-7.0 version to AccuRev 7.1, you must first obtain a new license.
For instructions on that procedure, see Get an AccuRev License on page 16.
See the AccuRev Administrator’s Guide for a full description of license management in AccuRev 7.1.

Database Upgrade
AccuRev 7.0 upgraded the PostgreSQL version from 8.4.3 to 9.5.3. After upgrading AccuRev from a pre7.0 version to 7.1, the system administrator must upgrade the database by running maintain migratepg
<db_admin>.
See the AccuRev Administrator’s Guide for more information.
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AccuRev Installation Notes
This chapter describes how to install and upgrade AccuRev 7.1 software at your site. In addition to
installation procedures, it provides information about installation package options, considerations for
upgrading, and post-installation procedures. AccuRev 7.1 is intended for new customers and for all
existing customers who wish to upgrade to the latest AccuRev release.
For a high-level summary of new features in Release 7.1, see What’s New in AccuRev Release 7.1 on
page 45. For a detailed list of changes, see Changes in AccuRev Release 7.1 on page 52.
This chapter is intended for the AccuRev administrator responsible for installing and upgrading AccuRev.
Users responsible for installing or upgrading their individual AccuRev client installations will probably be
most interested in the material discussed in Installing or Upgrading an AccuRev Client on page 27.

Compatibility with Previous Versions
The general rule for compatibility between AccuRev servers and clients is that the AccuRev server must be
the same version as, or newer than, the AccuRev client. Use of an AccuRev client that is newer than the
AccuRev server is not supported.
The 7.1 AccuRev server is compatible with AccuRev clients from Release 6.2.0 through 7.1.
IMPORTANT NOTE ABOUT LICENSES: Because AccuRev 7.0 introduced a new license manager
and license file format, it is necessary to obtain a new AccuRev license before upgrading from a pre-7.0
release to AccuRev 7.1. For instructions on that procedure, see Get an AccuRev License on page 16.
See the AccuRev Administrator’s Guide for a full description of the license management scheme
introduced in AccuRev 7.0.

System Requirements
AccuRev has the following system requirements
Client


Microsoft Windows 7 SP1 (32-bit and 64-bit)



Microsoft Windows 8 (32-bit and 64 bit)



Microsoft Windows 8.1 (64-bit)



Microsoft Windows 10 (64-bit)



Microsoft Windows Server 2008 SP2 (32-bit and 64-bit)



Microsoft Windows Server 2012 R2 (64-bit)



Microsoft Windows Server 2016 (64-bit)



Apple Mac OS X Yosemite 10.10 (64-bit)



Apple Mac OS X El Capitan 10.11 (64-bit)
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Apple macOS Sierra 10.12 (64-bit)



Apple macOS High Sierra 10.13 (64-bit)



Linux Red Hat Enterprise 5 (32-bit and 64-bit)



Linux Red Hat Enterprise 6 (32-bit and 64-bit)



Linux Red Hat Enterprise 7 (64-bit)



Linux SUSE 12+ (64-bit)



Linux Fedora 23+ (32-bit and 64-bit)



Linux Ubuntu 12+ (32-bit and 64-bit)



Linux CentOS 6 (64-bit)



Linux CentOS 7 (64-bit)



Unix IBM AIX 6.x (Command Line only)



Unix IBM AIX 7.x (Command Line only)



Unix Solaris 10 (Intel 64-bit)



Unix Solaris 11 (Intel 64-bit)

Server (AccuRev has supported only 64-bit servers since Release 6.2.3)


Microsoft Windows 7 SP1 (64-bit)



Microsoft Windows 8 (64 bit)



Microsoft Windows 8.1 (64-bit)



Microsoft Windows 10 (64-bit)



Microsoft Windows Server 2008 SP2 (64-bit)



Microsoft Windows Server 2012 R2 (64-bit)



Microsoft Windows Server 2016 (64-bit)



Linux Red Hat Enterprise 5 (64-bit)



Linux Red Hat Enterprise 6 (64-bit)



Linux Red Hat Enterprise 7 (64-bit)



Linux SUSE 12+ (64-bit)



Linux Fedora 23+ (64-bit)



Linux Ubuntu 12+ (64-bit)



Linux CentOS 6 (64-bit)



Linux CentOS 7 (64-bit)



Unix Solaris 10 (Intel 64-bit)



Unix Solaris 11 (Intel 64-bit)
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Browser Requirements
AccuRev has the following browser requirements:


Microsoft Internet Explorer 11 and later



Microsoft Edge



Mozilla Firefox 20 and later



Google Chrome 20 and later



Apple Safari 6 and later

Installation Overview
Generally speaking, installing AccuRev involves downloading an installation package from the Micro
Focus Web site and running it on the target machines at your site. One machine should be designated as the
AccuRev Server machine -- the one that runs the AccuRev Server process, the Web UI Server process, and
hosts the AccuRev data repository. Other machines can access the AccuRev Server after you install the
AccuRev Client software on them.
You can also have one or more replica servers in your environment. AccuRev replica servers enable you to
provide access to remote users spread across multiple geographic sites. Replication can also enable you to
distribute the load off a single server.

Installation Packages
AccuRev provides two installation packages: the AccuRev installation package, and the AccuRev Clientonly installation package.


The AccuRev installation package lets you install either:


The AccuRev Server and Web UI Server - This is the correct choice for a new customer setting up
the AccuRev infrastructure for the first time.



The AccuRev Web UI Server only - This is appropriate for users who wish to install only the
AccuRev Web UI.

Both installation types can be used to install AccuRev components for the first time, or to upgrade
existing AccuRev components. They can be run in either graphical (GUI) or text-based (console)
interactive modes.


The AccuRev Client-only installation package lets you install or upgrade just the AccuRev
Client. The client-only installation is useful if you just need to perform a simple client installation to
use with an existing, up-to-date AccuRev Server. In addition to graphical (GUI) and text-based
(console) interactive install modes, the Client-only installation package also supports a "silent" install
mode. The "silent" install requires the presence of a response file, which contains a record of responses
to prompts from an earlier installation. See Using "Silent" Client Installations on page 31 for more
information.
If you are installing the AccuRev Client for the first time, or if you are upgrading from a previous
version of AccuRev, you must download the AccuRev Client-only installation package for your
client’s platform from the Micro Focus SupportLine download page.
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If you are upgrading an existing client from AccuRev 5.7 or higher, however, consider using the
Upgrade Client feature. See Installing or Upgrading an AccuRev Client on page 27 for more
information.
AccuRev and AccuRev Client-only installation packages are available on the Micro Focus SupportLine
page (http://supportline.microfocus.com/).

The Mosquitto MQTT Message Broker
AccuRev supports Message Queue Telemetry Transport (MQTT) message broker communications. By
using an MQTT message broker, the AccuRev GUI client can automatically receive messages about
dynamic changes occurring in Gated Streams from the AccuRev Server.
As of AccuRev 6.2, the Mosquitto MQTT message broker is automatically installed on Windows, Linux,
and Solaris platforms so that the AccuRev server can update the AccuRev client with changes from the
AccuRev server. MQTT automatically starts after the install. However after a reboot, the administrator
should ensure that the process has been restarted or start it manually as required.
In a Windows environment, the Mosquitto message broker runs as a new service. By default, AccuRev
attempts to access port number 1883 to use this message broker. If this port number is already in use or if
your firewall denies access, the Mosquitto message broker does not work and the AccuRev GUI client has
to be refreshed manually.

Installation Wizards
AccuRev Installation Wizards guide you through the AccuRev installation process. The Installation
Wizard can be run in either a graphical (GUI) or text-based (console) mode.

Post-installation Administrative Scripts
AccuRev installation packages provide the ability to invoke a script or executable. To configure this
feature you simply set environment variable ACCUREV_POST_INSTALL to the fully-qualified path of
the script or executable. The AccuRev installer will execute that script as the last step of the installation
process.

Preparing for Installation
This section describes the steps to take to prepare for installing AccuRev 7.1, as summarized in the
following table.
Table 1. Preparing to Install AccuRev
Step

Action

Comments

1

Update the Operating System

Install all applicable updates for your operating system.
This will ensure successful installation of AccuRev.

2

Get an AccuRev License

You do not need a license to install just the AccuRev Client
or the AccuRev Web UI Server.

3

Determine Configurable Elements

The installation instructions use generic names. Refer to
this section to determine values appropriate for your site
prior to installation.
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Table 1. Preparing to Install AccuRev
Step
4

Action

Comments
If you are installing just the AccuRev Client, check with
your AccuRev administrator to see if the Upgrade Client
feature is available at your site.

Download the Installation Packages

Get an AccuRev License
In order to install AccuRev 7.1, you need an aclicense.txt license file. You do not need a license file to
install the AccuRev Web UI Server or AccuRev Client.
The process for getting an aclicense.txt license file varies based on several factors, including your current
license type and whether or not you are currently under maintenance, as summarized in the following table.
Table 2. Getting an AccuRev License
Type of
Installation

Current
License Type

Procedure

Comments

New

n/a

Use the License Request form at http://
supportline.microfocus.com/licensing/
AccuRevLicensing.aspx to get a license
for any new AccuRev installation.

None

Upgrade

accurev.lic

If you are currently under maintenance,
use the License Request form at http://
supportline.microfocus.com/licensing/
AccuRevLicensing.aspx to get a new
AccuRev license.

To determine whether or not you are
still under maintenance:
 In accurev.lic, check the
maintenance expiration date
shown in each license section as
replace options=<date>.

If you are not currently under
maintenance, contact a sales
representative.

Note: Use the AccuRev CLI command
hostinfo to obtain the name of the
License Manager host machine (Host
name), which is required by the
License Request form. (On 6.x
systems, be sure to use the "Host
name(RLM)" value, which may be
different from the "Host name" value.)

See the AccuRev Administrator’s Guide for a full description of license management in AccuRev 7.1.

Determine Configurable Elements
The installation and setup process involves a number of configurable elements. For simplicity and clarity,
the instructions consistently use a set of generic names, using <this font>. When you see a generic name
in a procedure, you must replace that name with the value that is appropriate for your site. For example,
you might replace <ac-install> with C:\Program Files\AccuRev.
Tip: Use the Name at Your Site column in the following table to record the names you plan to use.
Table 3. Generic and actual names used during installation
Generic Name
<installer-loc>
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Name at Your Site

Description
Location of the downloaded AccuRev installation package.

AccuRev® Installation and Release Notes

Generic Name

Name at Your Site

Description

<ac-install>

Location that AccuRev is installed to. Defaults to:
 (Windows) C:\Program Files\AccuRev (64-bit) or
C:\Program Files (x86)\AccuRev (32-bit)
 (UNIX/Linux) <homeDirectory>/accurev

<ac-storage>

Location of the AccuRev database and container files. Defaults to:
 (Windows) C:\Program Files\AccuRev\storage (64-bit)
 (UNIX/Linux) <homeDirectory>/accurev/storage

<ac-host>

Hostname of the AccuRev Server.

<ac-port>

Port number that the AccuRev Server runs on. Defaults to 5050.

<ac-user>

Name of the operating-system user that runs the AccuRev Server.
Defaults to: acserver.

<ac-pass>

Password for <ac-user>.

<db-port>

Port number that the database server runs on. Defaults to 5075.

<db-admin-name>

Name of the database superuser. Defaults to postgres.
Note: AccuRev recommends that you retain the default value,
postgres. If you create a different value for the database superuser, it
must be lowercase.

<db-admin-pass>

Password for <db-admin-name>.
Note: The database password must be lowercase.

Download the Installation Packages
On the Micro Focus supportline page
(http://supportline.microfocus.com/websync/productupdatessearch.aspx), download the appropriate
AccuRev installation package for your operating system to a local directory (referred to as <installerloc> throughout this document).
Users can install AccuRev by downloading the AccuRev installation package to the client machine and
manually running the installation package executable. Users can also start the installation automatically by
selecting Help > Upgrade Client in the GUI or by using the accurev upgrade_client in the CLI, if
someone (typically, the system administrator) has already downloaded the installation package to the
AccuRev server, copied it to the appropriate location, and renamed it as described in Enabling the Client
Upgrade feature on page 29.
If you download a compressed package (.zip or .gz file), first extract the files from the package before
continuing. Many extraction tools are freely available and the unzip and gunzip programs are standard on
many UNIX/Linux systems. The Mac OS X operating system does not require any special software for .zip
files -- just double-click the file to extract the install package.

What to Do Next
What to do next depends on whether you are installing or upgrading AccuRev, the AccuRev Client, or the
AccuRev Web UI Server, as summarized in the following table.
Table 4. Next Steps in the Installation Process
If You Are Installing or Upgrading

Go To

The AccuRev Server

Installing or Upgrading an AccuRev Server on page 19

Just the AccuRev Client

Installing or Upgrading an AccuRev Client on page 27
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Table 4. Next Steps in the Installation Process
If You Are Installing or Upgrading
Just the AccuRev Web UI Server

18

Go To
Installing or Upgrading the AccuRev Web UI Server on page 34
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Installing or Upgrading an AccuRev Server
The procedure for installing AccuRev is largely the same whether you are installing AccuRev for the first
time or you are upgrading an existing AccuRev installation. Note, however, that there are several important
considerations and prerequisites for users upgrading to AccuRev 7.1. See Server and Database Upgrades
on page 26 for more information on this topic.

Before You Begin
Whether you are performing a new AccuRev Server installation or upgrading an existing installation,
before installing AccuRev 7.1 you should:
1. Read the Platform Support Notes on page 47 for your operating system before proceeding, and follow
the instructions there.
2. If you are installing a new AccuRev Server on a UNIX/Linux machine, run the adduser command to
make an OS-level user (<ac-user>). You should set <ac-install> as the home directory for this user.
The AccuRev Server cannot be installed by root on UNIX/Linux platforms.
3. Acquire an aclicense.txt license file if you have not already done so. See Get an AccuRev License on
page 16 for more information.
Note: You must have an aclicense.txt file in order to install AccuRev 7.1.
4. If you are upgrading an existing AccuRev Server:


IMPORTANT: Perform a full backup of your AccuRev data. This includes backing up any
replica servers. For detailed instructions, see the section titled “Backing Up the Repository” in the
AccuRev Administrator’s Guide for your existing release. MAKE SURE TO USE THE
CORRECT BACK UP PROCEDURES FOR YOUR EXISTING INSTALLATION.



Read through the upgrade information that applies to your current AccuRev installation in Server
and Database Upgrades on page 26 before you start the installation process.



Plan a maintenance window for this upgrade and data migration, during which clients will not be
able to connect to the server. See the instructions at Upgrading a Replica Server on page 26 for
running a trial upgrade and estimating the time to complete the process.

5. Before starting the installation on UNIX/Linux, ensure that the LC_ALL environment variable is set to
a UTF-8 locale (such as "en_US.UTF-8", NOT "en_US.latin".) Windows installations are not affected,
however proceeding with a non UTF-8 locale on UNIX/Linux can lead to a failed, partially-complete
installation. Use the locale command to determine your current locale setting, and locale -a to
determine what locales are available. See the documentation for your operating system for details
about how to install and change locale settings.

Considerations for AccuRev Replication Servers
Before deciding to install a replica server, see the "Replication of the AccuRev Repository" and "License
Management" chapters in the AccuRev Administrator’s Guide. Before proceeding with replica server
installation, contact AccuRev Support Services for more information.

Use Native Shells
AccuRev recommends using only shells that are native to/installed with the OS. Avoid using third-party
shells as they do not always work as expected.
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Running the AccuRev Installation Wizard
This section describes how to run the AccuRev Installation Wizard. It assumes you have already
downloaded the correct installation package for your platform as described in Download the Installation
Packages on page 17.

Overview
The AccuRev wizard guides you through steps for installing a new AccuRev Server or upgrading an
existing server. If the Installation Wizard discovers that an AccuRev server already exists in the location
you specify, it will prompt you through the upgrade process.
Upgrading to 7.1 from a pre-7.0 AccuRev release requires a database upgrade, independent of the
installation process. The complexity of the database upgrade depends on the release from which you are
upgrading. See Server and Database Upgrades on page 26 for more information.
If the Installation Wizard determines that you have an existing, nonstandard 5.x database installation (for
example, if you installed your own copy of PostgreSQL, or you have multiple instances running on the
same machine), the installer will not continue. Nonstandard database installations are not supported. You
need to contact Micro Focus SupportLine (https://supportline.microfocus.com) to continue.
At the end of the installation, make sure that you tune your database parameters as described in
Configuring Database Tuning Parameters on page 38. You must reboot the database for the tuning
parameters to take effect.

Before You Begin
Before running the AccuRev Installation Wizard:
1. Log in -- Log in to the machine on which you will be installing AccuRev. Log in as <ac-user>
(UNIX/Linux) or a user with installation privileges (Windows). (See Before You Begin on page 19 to
learn about creating <ac-user> on UNIX/Linux machines.)
Note: For security reasons, you CANNOT install the AccuRev server on UNIX/Linux if you are
logged in as root.
2. Stop the AccuRev Server and AccuRev DB Server -- If you are upgrading an existing AccuRev
Server, you must stop the AccuRev Server and the AccuRev DB Server before you can install the
current version. See Starting and Stopping AccuRev Servers on page 45 if you need help with this step.
Tip: Stopping the AccuRev DB Server also stops the AccuRev Server.
3. Stop the AccuRev Tomcat Server and the Mosquitto MQTT Message Broker -- If you are
upgrading an existing AccuRev Server, you must stop the AccuRev tomcat Server and the Mosquitto
MQTT Message Broker.
4. IMPORTANT: Verify that the Tomcat process has stopped -- The Tomcat process sometimes
continues even when the Tomcat service has been stopped. Manually terminate the process if
necessary.

How to Run the AccuRev Installation Wizard
This section describes how to install AccuRev using the AccuRev Installation Wizard.
Note: The specific prompts that you see and the order in which you see them can vary depending on
your particular installation and the options that you select. Not all users will see all the prompts
described in the following procedure, which focuses on the graphical version of the Installation Wizard
but provides information about console mode in [brackets].
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To run the AccuRev Installation Wizard:
1. Start the Installation Wizard -- Start the AccuRev Installation Wizard you downloaded from the
Micro Focus web site by double-clicking the installer icon, or by entering the installer name on the
command line as summarized in the following table. Note that the installation program can be run with
a graphical user interface (GUI) or as a console (text-only) application.
Table 5. Starting the AccuRev Installation Wizard
Platform
Windows

UNIX/Linux

Installation Mode

Run This Procedure

GUI

accurev-n.n.n-windows.exe
where _n_n_n is the AccuRev version number
accurev-7.1-windows.exe, for example

Console (text-based)

accurev-n.n.n-windows.exe -i console
where _n_n_n is the AccuRev version number
accurev-7.1-windows.exe -i console, for example

GUI

sh accurev-n.n.n-platform.bin
where:
 -n.n.n is the AccuRev version number
 platform is the UNIX/Linux platform name
sh accurev-7.1-linux-x86.bin, for example

Console (text-based)

sh accurev-n.n.n-platform.bin - i console
where:
 -n.n.n is the AccuRev version number
 platform is the UNIX/Linux platform name
sh accurev-7.1-linux-x86.bin - i console, for example

Tip: If you are installing AccuRev from the console you can type:


"back" to return to the previous prompt in the installation program



"quit" to exit the installation program

2. License Agreement -- Before you can proceed, you must click “I accept the terms of the License
Agreement.” and then click Next to continue. [Console: You can type "y" to agree, "n" to refuse, or
press Enter to page through the license agreement.]
3. Confirm Administrator Privileges -- If the installer prompts you for this information:


Windows: Specify whether or not the current user has Administrator privileges on the current
machine. Note that Windows requires that you have Administrator privileges.



UNIX/Linux: Specify whether the current user is root. Note that for security reasons, you
CANNOT install the AccuRev server on UNIX/Linux if you are logged in as root.

4. Choose Install Folder -- Specify a different directory if you do not want to use the <ac-install>
defaults: <homeDirectory>/accurev on UNIX/Linux, C:\Program Files\AccuRev on Windows.
See Determine Configurable Elements on page 16 if you are not familiar with the values represented
by <ac-install> and <homeDirectory>.


If you are installing software for the first time, and do not wish to use the default location, specify
a location where you have write permission.



If you are upgrading and the existing installation is not at the default location, specify your
existing AccuRev installation directory.
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Click Next to accept the default and continue. [Console: Press Enter to accept the default and
continue.]
5. Choose Installation Type (for new installs only) -- Select one of the following:


AccuRev Server and Web UI Server -- Installs the AccuRev Server, the AccuRev Web UI
Server, and a local AccuRev Client. Note that the AccuRev Web UI Server includes an Apache
Tomcat web server. [Console: Press Enter to install the AccuRev Server and Web UI Server.]



Web UI Server only -- Installs only the AccuRev Web UI Server and AccuRev Client. If you
choose this installation option, click Next and go to Installing or Upgrading the AccuRev Web UI
Server on page 34 to complete the installation. [Console: Type "2" and press Enter to install the
Web UI Server only.]

6. Install Replication (for new installs only) [Console: “Choose Replication Type”] -- Choose No
replication [Console: type “1” for None] unless you have already determined (along with AccuRev
Support Services) that your site will be implementing one or more replica servers. If you have any
questions about AccuRev replication servers, refer to Considerations for AccuRev Replication Servers
on page 19 before continuing.
If you know for a fact that your site is implementing replica servers, select either:


“Yes, this is the master” for the site that will be sending elements out to the replica [Console: type
"2" for Master.]



“Yes, this is the replica” for the site (typically remote) that will be connecting to a master server
to receive files [Console: type "3" for Replica.]

Proceed through the remainder of the installation program. When prompted for replication options,
confirm your choice of master server or replica server as appropriate.
To upgrade an existing replica server, see Upgrading a Replica Server on page 26.
Note: Installing the replica software is only part of the process. Before you can use a newly-installed
replica server, you need to configure both it and the master server. Configuration and licensing
information about replica servers is located in the “Replication of the AccuRev Repository” and
“License Management” chapters in the AccuRev Administrator’s Guide.
7. Choose a Folder for AccuRev Server Data Storage (for new installs only) -- If you do not want to
use the <ac-storage> default (<homeDirectory>/accurev/storage on UNIX/Linux, C:\Program
Files\AccuRev\storage on Windows), specify a different directory in the Please Choose a Folder
field. AccuRev creates the folder you specify if it does not already exist.
Note: Ensure that the path you specify is LOCAL disk storage (not a network drive) and that it has
plenty of space.
Click Next to continue. [Console: Press Enter to accept the default and continue.]
8. Choose a Folder for AccuRev Server Database (not displayed for 7.x.x-to-7.1 upgrades) -- If you do
not want to use the default (<homeDirectory>/accurev/postgresql/9.5 on UNIX/Linux,
C:\Program Files\AccuRev\postgresql\9.5 on Windows), specify a different directory in the
Please Choose a Folder field. AccuRev creates the folder you specify if it does not already exist.
Note: Ensure that the path you specify is LOCAL disk storage (not a network drive) and that it has
plenty of space.
Click Next to continue. [Console: Press Enter to accept the default and continue.]
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9. Configure Database Port and User (not displayed for 7.x.x-to-7.1 upgrades) -- Enter the values for
the Database Port (<db-port>) and Superuser Name (<db-admin-name>) fields. [Console:
Prompts for these values individually.]
Unless the default database port "5075" conflicts with something else on your machine, you should not
change the value in the Database Port field. Likewise, AccuRev recommends that you keep the
default value "postgres" for the Superuser Name unless you have a specific reason to change it.
Note: If you create a different value for the database superuser, it must be lowercase.
10. Configure Database Password (not displayed for 7.x.x-to-7.1 upgrades) [Console: “Set Database
Superuser Password”.] -- In the Superuser Password field, enter the value for <db-admin-pass> that
you chose in Table 3 on page 16. Enter it again in the Confirm Superuser Password field. Make sure
that you record this password in a secure location for later use.
Note: The database password must be lowercase.
11. Specify License Source (not displayed for replica server installations) -- Select one of the following:


Local License File -- This means that license information should be obtained from a local license
file. [Console: type "1" for Local License File.]



Remote License Server -- This means that a different AccuRev master server will serve AccuRev
licenses to this AccuRev server. [Console: type "2" for Remote License Server.]

12. Specify AccuRev License Location (only if "Local License File" was specified as the license source)
-- Specify the full path of your local aclicense.txt license file. If the Installation Wizard detects an
existing aclicense.txt file where you have chosen to install AccuRev, it initialized the field to that
location. [Console: Press Enter to accept the default and continue.]
For more information about licensing, see the “License Management” chapter in the AccuRev
Administrator’s Guide.
13. Configure Remote License Server (only if "Remote License Server" was specified as the license
source) -- Enter values for the following:


Host -- The host name of the AccuRev master license server (which will serve licenses to this
AccuRev server)



Port -- The port that the master license server will listen on (typically port 5050)



Username -- The username associated with the Remote License User account on the master
license server



Password -- The password for the Remote License User account on the master license server

14. Upgrade install detected (for upgrade installs only) -- For an upgrade install, the Installation Wizard
collects all the remaining information that it needs from the existing installation. Click Next and go to
the Pre-Installation Summary (Step 17 below). [Console: Press Enter to go to the Pre-Installation
Summary.]
15. Configure: Set Host and Port (for new installs only) [Console: Choose Hostname and Port number]
-- Review the default values for the Host and Port fields for the AccuRev Server. You should accept
the default values chosen by the Installation Wizard unless you have a good reason to change them.
[Console: Review the host name value, then press Enter to continue; then review the port value and
press Enter to continue.]
Click Next to continue.
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16. Adjust System PATH Variable (for new installs only) -- Responding Yes enables the AccuRev
Installation Wizard to modify the PATH environment variable on your system so that you do not need
to specify a full path on the command line when using AccuRev commands. Click Install to continue.
[Console: Type "y" and press Enter to continue.]
Note: You might need to reboot after installation before changes to the PATH environment variable
take effect.
17. Pre-Installation Summary -- At this point, the Installation Wizard displays all the installation
parameters garnered from user input or a previous installation. Click Install to continue; otherwise,
click Previous to change a value. [Console: Press Enter to continue; otherwise, type "back" and then
press Enter to change a value.]
18. Installing AccuRev -- The Installation Wizard displays a splash screen [Console: displays "Installing"
with a progress bar] while it installs the software on your local machine. It displays a Please Wait
message while it performs configuration tasks.
19. Database Tuning -- The Installation Wizard reminds you that you can use database tuning parameters
to improve performance. See Configuring Database Tuning Parameters on page 38 for more
information. Click Next to continue. [Console: Press Enter to continue.]
20. Reminder (for 7.x.x-to-7.1 upgrades only) -- If you are upgrading from AccuRev 7.0 or 7.0.1 to 7.1,
the Installation Wizard reminds you to run maintain dbupgrade to migrate to the database version
that is installed with AccuRev 7.1. Click Next to continue. [Console: Press Enter to continue.]
21. Configure: Start AccuRev Server (for new installs only) -- In a new installation, the Installation
Wizard prompts you to start the AccuRev Server. Accept the default value (Yes) unless you want to
start it later. Click Next to continue.
Note: See Starting and Stopping AccuRev Servers on page 45 if you choose to start the AccuRev
Server at a later time.
22. Configure: Start AccuRev WebUI Server -- The Installation Wizard prompts you to start the
AccuRev Web UI Server. Accept the default value (Yes) unless you want to start it later. Click Next to
continue.
Note: See Installing or Upgrading the AccuRev Web UI Server on page 34 for more information on
Web UI Server installation and configuration.
23. Install Complete -- The Installation Wizard displays a message when the installation is complete.
To exit, click Done. [Console: Press Enter.]
24. Postgresql Upgrade Required (for upgrade installs from a pre-7.0 version) -- If you are upgrading
from AccuRev 5.7 or 6.x, the Installation Wizard reminds you to run maintain migratepg to migrate
to the new database version.
To exit, click Done. [Console: Press Enter.]
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What to Do Next
What to do after a successful AccuRev installation depends on whether you performed a new installation
or an upgrade, as summarized in the following table:
Table 6. Upgrading to AccuRev 7.1
Installation Type
New

Next Steps
If you chose not to start the AccuRev Server as
part of the installation process, you must start it
before you can use AccuRev.
If you plan to make the AccuRev Web UI available
to your users, you must:
 Start the Web UI Server if you chose not to start
it as part of the installation process
 Configure the Web UI for use with theAccuRev
GUI

Upgrade

After upgrading to AccuRev 7.1, you need to:
 Run a command to migrate your database to the
current version installed with AccuRev:
 maintain migratepg, if you are upgrading
from a pre-7.0 version of AccuRev
 maintain dbupgrade, if you are upgrading
from version 7.0 or 7.0.1
 Start the AccuRev Server

For More Information
See Starting and Stopping AccuRev
Servers on page 45

Go to Starting, Stopping, and Testing the
AccuRev Web UI Server on page 37
Go to Configuring the AccuRev Web UI
on page 37
Go to:

 Upgrading a Server from a 5.7 or 6.x
Version on page 26

 Using the ‘maintain dbupgrade’
Command on page 40

 Starting and Stopping AccuRev
Servers on page 45

Tomcat Customization and AccuRev Upgrades
The AccuRev Web UI uses the Tomcat web server. The following table shows what Tomcat version is
installed with what AccuRev version:
AccuRev Version

Tomcat Version

7.1

8.0.47

7.0.1

8.0.43

7.0

8.0.33

6.1 through 6.2.3

7

Pre-6.1

6

If you customized the Tomcat web server (e.g., by modifying the server.xml file) for an earlier release of
AccuRev and are now upgrading to AccuRev 7.1, you must migrate your Tomcat changes to the Tomcat
8.0.47 version that is installed with AccuRev 7.1.
To help you with this process, the upgrade install moves your previous Tomcat installation from the
<AccuRev_install>\WebUI\tomcat directory to <AccuRev_install>\WebUI\tomcat.old. You can
examine your old customizations in tomcat.old and make comparable changes in the tomcat directory.
If you have not customized Tomcat at all, you can safely remove the tomcat.old directory after the upgrade
install has completed.
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Server and Database Upgrades
This section contains instructions for upgrading AccuRev databases from previous releases to 7.1. Note
that if you have existing replica servers, you must also follow the instructions in Upgrading a Replica
Server on page 26. AccuRev strongly recommends that you first perform a trial upgrade of your production
data on a separate test machine to determine if you will encounter any issues, and to estimate how long the
upgrade is likely to take so that you will know how long your servers will be unavailable to your users.
AccuRev 7.1 supports upgrades from existing 5.7 and later installations. In order to upgrade from a pre-5.7
version, you must first perform an upgrade installation to 5.7 or a 6.x version. (We recommend the latest
pre-7.0 version, which is 6.2.3.) Refer to the release notes associated with that release for more detailed
information on upgrading from prior versions.

Upgrading a Server from a 5.7 or 6.x Version
The upgrade process from an AccuRev version 5.7 or 6.x includes a PostgreSQL update. To do this update,
you must manually run the maintain migratepg <db_admin> command after the installer completes:
1. Make sure that you have performed the log in and back up steps described in Before You Begin on
page 19 and Running the AccuRev Installation Wizard on page 20.
2. After the upgrade installation completes, PostgreSQL 9.5 should be running. The AccuRev server will
not be running and cannot be started until the migration completes successfully.
3. Run the maintain migratepg <db_admin> command and be sure to specify the same database
password (<db-admin-pass>) that is used by your existing database.
4. Confirm the PostgreSQL 8.4 database location. Typically this is <ac-storage>/db/.
5. Confirm the location of the pg_dump backup file. This defaults to <ac-storage>/site_slice/
backup/. The backup file will be roughly equivalent in size to your database, so be sure that you have
enough free disk space in the selected location.
6. The migratepg process will then perform the following steps:


Start PostgreSQL 8.4 server.



Backup the 8.4 metadata.



Stop the PostgreSQL 8.4 server.



Start PostgreSQL 9.5 if it is not already running.



Restore the 8.4 metadata into 9.5.



Upgrade the database schema if needed.



Move the PostgreSQL 8.4 binaries to <ac-install>/postgresql/8.4/.



Move the <ac-storage>/db/ directory to <ac-install>/postgresql/8.4/db/. (If unable to
move, the db directory will be renamed.)

Upgrading a Replica Server
Use these instructions to upgrade an existing AccuRev replica server:
1. Perform a full backup and ensure that you have enough disk space as discussed above in Before You
Begin on page 19.
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If your site uses AccuWork: For every replicated depot that has AccuWork issues, copy the entire
<ac-storage>/depots/<depotName>/dispatch directory from the master server to each replica
server. Tip: Run "accurev show slices" to see the exact locations of your depots.
2. Proceed with the installation as if the replica server were a master server. See Upgrading a Server from
a 5.7 or 6.x Version on page 26.
3. After the upgraded replica server has started, execute the following command against the replica
server:
accurev replica sync

Installing or Upgrading an AccuRev Client
This section describes the methods available to install and upgrade AccuRev Client software and
procedures for their use.
Note: In this section, any instructions or comments about the UNIX/Linux platform apply to Linux,
Solaris, AIX, and Mac OS X platforms.

Installation Methods
There are two methods for installing or upgrading the AccuRev Client:




An interactive AccuRev Client-only installation requires the user to run an Installation Wizard and
provide information during the installation process. There are two possible ways to accomplish this:


If you download the Client-only installation package to the client machine and run the installation
executable manually, you can run the installation package with a graphical user interface (GUI) or
as a console (text-only) application. See Using the AccuRev Client-only Installation Package on
page 28 for more information.



If you are upgrading an AccuRev version 5.7 (or later) client, and someone (typically, the system
administrator) has already downloaded the installation package to the AccuRev server, copied it to
the appropriate location, and renamed it as described in Enabling the Client Upgrade feature on
page 29, then you can automatically start the installation by selecting the Help -> Upgrade Client
option in the AccuRev GUI or by using the accurev upgrade_client in the CLI.

A "silent" AccuRev Client installation is typically used by the AccuRev administrator to automate the
client installation or upgrade process in a distributed or networked environment. "Silent" installations
are run from the command line and do not require any interaction by the end-user. See Using "Silent"
Client Installations on page 31 for more information.
Tip: Ask your AccuRev administrator if the "silent" client installation method has been implemented at
your site.

Before You Begin
Regardless of which installation method you use, review the following steps before installing or upgrading
the AccuRev Client:
1. Read the Platform Support Notes on page 47 for your operating system before proceeding, and follow
the instructions there.
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2. (Mac OS X users only) If you are installing the AccuRev Client on Mac OS X 10.7.5 or later, make
sure the Gatekeeper feature is set to allow applications to be downloaded from Anywhere. To access
this setting from the Apple menu, go to System Preferences… > Security & Privacy > General tab.
Tip: The AccuRev Client displays a notification message if it requires upgrading. This can happen when
the AccuRev Server has been upgraded but the AccuRev Client has not. The notification message gives the
user the option of downloading the AccuRev Client-only installation package directly from the AccuRev
Server.

Uninstalling Existing AccuRev Clients
If you are upgrading an AccuRev client, you do not need to uninstall any existing software. The AccuRev
Installation Wizard lets you preserve your development data and configuration files, and installs the
upgrade in the same place as your existing version.

Using Native Shells
AccuRev recommends using only shells that are native to/installed with the OS.

Using the AccuRev Client-only Installation Package
The AccuRev Client-only installation package lets you install a new AccuRev Client or upgrade an
existing installation.

Downloading the Client-only Installation Package
If you have not already done so, take the following steps to download AccuRev client-only installation
packages:
1. Navigate to Product Updates on the Micro Focus Support Line page:
http://supportline.microfocus.com/
2. Select a search mechanism, then click Find Updates.
3. Check the license agreement, and then expand the Product and Version tabs to locate the appropriate
AccuRev release.
4. Locate the client-only installation packages you require and click the download button.
5. Depending on the installation package you have chosen, the downloaded file is a


.exe file for Windows,



.bin file for UNIX/Linux, or



.zip file for Mac OS X and AIX.

Save this file to the appropriate location, which depends on your preferred method of installation:
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If you are a user planning to install AccuRev on your client machine manually, save the file to your
client machine.



If you are an administrator who intends to make the file available to your users so that they can get
the file, copy it to their client machines, and run it manually, then save the file to some location and
inform your users where they can get the file to install it themselves.



If you are an administrator and you want to enable the Client Upgrade feature for users who have
an existing installation of AccuRev 5.7 or later, then save the file to the appropriate location on the
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AccuRev server and rename the file as described in the following section, Enabling the Client
Upgrade feature.

Enabling the Client Upgrade feature
Note: The Client Upgrade feature is not supported on the AIX platform
If you are an administrator and you want to enable the Client Upgrade feature, take the following steps:
1. Download the client as described in Downloading the Client-only Installation Package.
2. When prompted, rename the file you just downloaded according to the operating system
Table 7. Operating System and Names
Operating System

File Name

Windows

AccuRevClientInstall.exe

UNIX/Linux

AccuRevClientInstall.bin

Mac OS X

AccuRevClientInstall.zip

and copy it to the appropriate appropriate directory under <ac-install>/bin/installers. For example, if
you downloaded accurev-7.1-windows-clientonly.exe on a Windows machine, then save it to
c:\Program Files\AccuRev\bin\installers\Windows\AccuRevClientInstall.exe.
Important : Client-only install packages must be named as mentioned in table Operating System and
Names or they will not be recognized by the client upgrade feature.
The client-only installation package is now available for AccuRev users, who can automatically
upgrade their AccuRev client by selecting Help > Upgrade Client in the GUI or by using the accurev
upgrade_client in the CLI.

Running the Client-only Installation Package
To run the AccuRev Client-only installation package, take the following steps:
1. Start the installation:


If you are running the installation manually on your client, proceed to step 2.



If the Client Upgrade feature has been enabled as described in the previous section, Enabling the
Client Upgrade feature, start the installation by selecting Help > Upgrade Client in the GUI or by
using the accurev upgrade_client in the CLI.

2. If you are manually installing AccuRev on your client machine, start the AccuRev Client Installation
Wizard using the applicable procedure:
Table 8. Starting the AccuRev Client Installation Wizard
Platform
Windows

Installation Mode

Run This Procedure

GUI

accurev-n.n.n-windowsclientonly.exe
where -n.n.n is the AccuRev version number
accurev-7.1-windowsclientonly.exe, for example

Console (text-based)

accurev-n.n.n-windowsclientonly.exe -i console
where -n.n.n is the AccuRev version number
accurev-7.1-windowsclientonly.exe -i console, for example
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Table 8. Starting the AccuRev Client Installation Wizard
Platform
UNIX/Linux

Mac OS X

AIX

Installation Mode

Run This Procedure

GUI

sh accurev-n.n.n-platform.bin
where:
 -n.n.n is the AccuRev version number
 platform is the UNIX/Linux platform name
sh accurev-7.1-linuxclientonly-x86.bin, for example

Console (text-based)

sh accurev-n.n.n-platform.bin - i console
where:
 -n.n.n is the AccuRev version number
 platform is the UNIX/Linux platform name
sh accurev-7.1-linuxclientonly-x86.bin
- i console, for example

GUI

Double-click the accurev-n.n.n-macosx-clientonly.zip to extract the
AccuRevClientInstall install package where:
 -n.n.n is the AccuRev version number.
Double-click AccuRevClientInstall install package to launch the
installer.

Console (text-based)

Double-click the accurev-n.n.n-macosx-clientonly.zip to extract the
AccuRevClientInstall install package where:
 -n.n.n is the AccuRev version number.
On the command line, run:
AccuRevClientInstall.app/Contents/MacOS/
AccuRevClientInstall

Console (text-based)

Move the downloaded file accurev-n.n.n-aix-clientonly-binaries.zip
from <installer-loc> to <ac-install>.
 Unzip accurev-n.n.n-aix-clientonly-binaries.zip

Tip: If you are installing the AccuRev Client from the console you can type:


"back" to return to the previous prompt in the installation program



"quit" to exit the installation program

Shutdown Existing AccuRev Apps -- When you start the AccuRev Client Installation Wizard, it first
reminds you to shut down any existing AccuRev applications. Click Next to continue. [Console: Press
Enter to continue.]
Note: The remaining steps in this section are not relevant to AIX installation.
3. License Agreement -- Before you can proceed, you must click "I accept the terms of the License
Agreement." and then click Next to continue. [Console: You can type "y" to agree, "n" to refuse, or
press Enter to page through the license agreement.]
4. Choose Install Folder -- Specify a different directory if you do not want to use the <ac-install>
defaults: <homeDirectory>/AccurevClient on UNIX/Linux, C:\Program Files\AccuRevClient
on 64-bit Windows, C:\Program Files (x86)\AccuRevClient on 32-bit Windows. (See Determine
Configurable Elements on page 16 if you are not familiar with the values represented by <acinstall> and <homeDirectory>.)
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If you are installing software for the first time and do not wish to use the default location, specify a
location where you have write permission.
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IMPORTANT: If you are installing the AccuRev Client on a machine running Windows Vista,
you must install AccuRev in the \Users folder. If you install to the default Windows directory
(C:\Program Files\, for example), you not be able to use the Upgrade Client feature to upgrade
your AccuRev Client in the future.


If you are upgrading and the existing installation is not at the default location, specify your
existing AccuRev installation directory.

Click Next to accept the default and continue. [Console: Press Enter to accept the default and
continue.]
5. Configure: Set Host and Port [Console: Choose What Server to Connect To] -- Specify the values for
the Host and Port fields for the AccuRev Server to which this client will connect. You should accept
the default value for the server port chosen by the Installation Wizard unless you have a good reason to
change it. Click Next to continue. [Console: Prompts for these values individually. Type a value for the
host name and press Enter to continue. Review the value for the port number and press Enter again to
continue.]
6. Adjust System PATH Variable -- Responding Yes enables the AccuRev Client Installation Wizard to
modify the PATH environment variable on your system so that you do not need to specify a full path on
the command line when using AccuRev commands. Click Next to continue. [Console: Enter "y" and
press Enter to continue.]
Note: You might need to reboot after installation before changes to the PATH environment variable
take effect.
7. Pre-Installation Summary -- At this point, the Installation Wizard displays a summary of the choices
you have made regarding your installation. Click Install to continue; otherwise, click Previous to
change a value. [Console: Press Enter to continue; otherwise, type "back" and then press Enter to
change a value.]
8. Installing AccuRevClient -- The Installation Wizard displays a splash screen [Console: displays
"Installing..." and a progress bar] while it installs the software on your local machine. It displays a
Please Wait message while it performs configuration tasks.
9. Installation Complete -- The Installation Wizard displays a message when the installation is
complete. Click Next to exit the program. [Console: Press Enter to exit the program.]
Note: If you are using the GUI installation wizard, when the installation is complete you are given the
opportunity to start the AccuRev user interface. To start the AccuRev user interface, accept the default
value of Yes and click Done. Otherwise, select No and click Done.

Using "Silent" Client Installations
So-called "silent" client installations allow the AccuRev Client software to be installed or upgraded in an
automated fashion, without requiring any interaction or input by the user on whose machine the AccuRev
Client is being installed. "Silent" client installations are particularly useful when AccuRev Client
installations or upgrades can be performed by a centralized software distribution mechanism. "Silent"
client installations provide a highly efficient mechanism for large AccuRev deployments to keep pace with
current versions of AccuRev.
Note: The "silent" upgrade is not supported for Mac OS X clients.

AccuRev® Installation and Release Notes

31

Overview
In a "silent" client installation, the Client-only installation package is pushed to each client machine. Then,
an AccuRev Client is installed manually on a single machine using a command line option to create a
response file. The response file records choices made during installation of the AccuRev Client, including:


Installation directory



The host (or IP address) and port number associated with the AccuRev Server



Whether or not "<ac_install>/bin" should be added to the user’s path. See Determine Configurable
Elements on page 16 if you are not familiar with the value represented by
<ac-install>.

The response file resulting from the manual installation can then be used as input by the "silent" client
installer to automate the installation process on your system’s clients. Note that if you have clients on
multiple platforms (Windows and Linux, for example), you must perform one manual client installation on
each of them to create platform-specific response files.
Sample Response File. An example response file for a Windows installation is shown here:
# Wed Aug 01 17:50:06 EDT 2012
# Replay feature output
# --------------------# This file was built by the Replay feature of InstallAnywhere.
# It contains variables that were set by Panels, Consoles or Custom Code.

#Choose Install Folder
#--------------------USER_INSTALL_DIR=C:\\Program Files\\myAccuRev

#Configure: Set Host and Port
#---------------------------HOST_NAME_INPUT=localhost
HOST_PORT_INPUT=5050

#Adjust System PATH Variable
#--------------------------ADD_TO_PATH_INPUT_RESULTS=\"Yes\",\"\"
ADD_TO_PATH_INPUT_RESULTS_1=Yes
ADD_TO_PATH_INPUT_RESULTS_2=
ADD_TO_PATH_INPUT_RESULTS_BOOLEAN_1=1
ADD_TO_PATH_INPUT_RESULTS_BOOLEAN_2=0

#Install
#-------fileOverwrite_C\:\\Program\ Files\\myAccuRev\\bin\\UninstallerData\\Uninstall\
AccuRev.lax=Yes
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-fileOverwrite_C\:\\Program\
Files\\myAccuRev\\bin\\UninstallerData\\resource\\iawin32.dll=Yes
-fileOverwrite_C\:\\Program\
Files\\myAccuRev\\bin\\UninstallerData\\resource\\win64_32_x64.exe=Yes
-fileOverwrite_C\:\\Program\
Files\\myAccuRev\\bin\\UninstallerData\\resource\\remove.exe=Yes
-fileOverwrite_C\:\\Program\ Files\\myAccuRev\\bin\\vcredist_x86_2010.exe=Yes
-fileOverwrite_C\:\\Program\ Files\\myAccuRev\\bin\\vcredist_x64_2010.exe=Yes
-fileOverwrite_C\:\\Program\ Files\\myAccuRev\\bin\\acgui.lax=Yes
-fileOverwrite_C\:\\Program\ Files\\myAccuRev\\bin\\acdiffgui.lax=Yes
-fileOverwrite_C\:\\Program\ Files\\myAccuRev\\bin\\acclient.cnf=Yes
-fileOverwrite_C\:\\Program\ Files\\myAccuRev\\LICENSE.TXT=Yes

#Start AccuRev User Interface
#---------------------------START_UI_INPUT_RESULTS=\"\",\"No\"
START_UI_INPUT_RESULTS_1=
START_UI_INPUT_RESULTS_2=No
START_UI_INPUT_RESULTS_BOOLEAN_1=0
START_UI_INPUT_RESULTS_BOOLEAN_2=1

Creating the Response File
To create the response file, run the AccuRev Client-only installer from the command line. Use the
-r <filename> option to specify the full path of the response file. Note that if you have clients on multiple
platforms (Windows and Linux, for example), you must run the client installation procedure on one
machine on each platform in order to create platform-specific response files.
Windows example
<installer_loc>\accurev-7.1-windowsclientonly.exe –r c:\tmp\ac_win_install.out

UNIX/Linux example
<installer_loc>/accurev-7.1-linuxclientonly-x86.bin
–r /tmp/ac_linux_install.out

Running a "Silent" Installation
Once you have created the response file for a given platform, you can use it to perform automated "silent"
installations on other clients for that platform. To run a "silent" installation, invoke the AccuRev Clientonly installation package from the command line. Use the -i silent option to specify the installation type,
and the -f <filename> option to specify the full path of the response file to use as input.
Windows example
<installer_loc>\accurev-7.1-windowsclientonly.exe -i silent
–f c:\tmp\ac_win_install.out

UNIX/Linux example
<installer_loc>/accurev-7.1-linuxclientonly-x86.bin -i silent
–f /tmp/ac_linux_install.out
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Installing or Upgrading the AccuRev Web UI Server
This section provides background information and procedures for installing or upgrading the AccuRev
Web UI Server as a standalone installation using the AccuRev Installation Wizard.
This section is intended for the AccuRev administrator. If you are an end user and want to use the Web UI
client, you simply need to open a supported Web browser and point it to an existing Web UI Server using
URL information provided to you by your administrator.
Note: If you have already installed AccuRev as described in Step 5 of Running the AccuRev Installation
Wizard on page 20, the AccuRev Web UI Server is already installed. Go to What to Do Next on page 36.

Before You Begin
Before running the AccuRev Installation Wizard:
1. Log in -- Log in to the machine on which you will be installing the AccuRev Web UI Server. Log in as
<ac-user> (UNIX/Linux) or a user with installation privileges (Windows). (See Before You Begin on
page 19 to learn about creating <ac-user> on UNIX/Linux machines.)
Note: For security reasons, you CANNOT install the AccuRev server on UNIX/Linux if you are
logged in as root.
2. Stop the AccuRev Tomcat Server -- If you are upgrading an existing AccuRev Web UI Server, you
must stop the AccuRev Tomcat Server.
3. IMPORTANT: Verify that the Tomcat process has stopped -- The Tomcat process sometimes
continues even when the Tomcat service has been stopped. Manually terminate the process if
necessary.

How to Run the AccuRev Web UI Server Installation Wizard
This section describes how to install the AccuRev Web UI Server using the AccuRev Installation Wizard.
If you are running the Installation Wizard in console mode, instructions are displayed in italicized brackets,
[Like this.]
To run the AccuRev Installation Wizard:
1. Start the Installation Wizard -- Start the AccuRev Installation Wizard you downloaded from the
Micro Focus SupportLine web site by double-clicking the installer icon, or by entering the installer
name on the command line as summarized in the following table. Note that the installation program
can be run with a graphical user interface (GUI) or as a console (text-only) application.:
Table 9. Starting the AccuRev Installation Wizard
Platform
Windows
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Installation Mode

Run This Procedure

GUI

accurev-n.n.n-windows.exe
where -n.n.n is the AccuRev version number
accurev-7.1-windows.exe, for example

Console (text-based)

accurev-n.n.n-windows.exe -i console
where -n.n.n is the AccuRev version number
accurev-7.1-windows.exe -i console, for example
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Table 9. Starting the AccuRev Installation Wizard
Platform
UNIX/Linux

Installation Mode

Run This Procedure

GUI

sh accurev-n.n.n-platform.bin
where:
 -n.n.n is the AccuRev version number
 platform is the UNIX/Linux platform name
sh accurev-7.1-linux-x86, for example

Console (text-based)

sh accurev-n.n.n-platform.bin - i console
where:
 -n.n.n is the AccuRev version number
 platform is the UNIX/Linux platform name
sh accurev-7.1-Linux_x86 - i console, for example

Tip: If you are installing AccuRev from the console you can type:


"back" to return to the previous prompt in the installation program



"quit" to exit the installation program

2. License Agreement -- Before you can proceed, you must click “I accept the terms of the License
Agreement.” and then click Next to continue. [Console: You can type "y" to agree, "n" to refuse, or
press Enter to page through the license agreement.]
3. Choose Install Folder -- Specify a different directory if you do not want to use the <ac-install>
defaults: <homeDirectory>/accurev on UNIX/Linux, C:\Program Files\AccuRev on Windows.
(See Determine Configurable Elements on page 16 if you are not familiar with the values represented
by <ac-install> and <homeDirectory>.)


If you are installing software for the first time, and do not wish to use the default location, specify
a location where you have write permission.



If you are upgrading and the existing installation is not at the default location, specify your
existing AccuRev installation directory.

Click Next to accept the default and continue. [Console: Press Enter to accept the default and
continue.]
4. Upgrade install detected (for upgrade installs only) -- For an upgrade install, the Installation Wizard
collects all the remaining information that it needs from the existing installation. Click Next and go to
the Pre-Installation Summary (Step 8 below). [Console: Press Enter to go to the Pre-Installation
Summary.]
5. Choose Installation Type -- Select Web UI Server only and then click Next to continue. [Console:
Type "2" and press Enter to continue.]
6. Configure: Set Host and Port -- In the Host and Port fields, set values for the AccuRev Server that
the Web UI will use and click Next to continue. [Console: Prompts for these values individually. Type
a value and press Enter to continue.]
7. Adjust System PATH Variable -- Responding Yes enables the AccuRev Installation Wizard to
modify the PATH environment variable on your system so that you do not need to specify a full path on
the command line when using AccuRev commands. Click Next to continue. [Console: Type "y" and
press Enter to continue.]
Note: You may need to logout and login again after installation in order for changes to the PATH
environment variable to take effect.
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8. Pre-Installation Summary -- At this point, the Installation Wizard displays all the installation
parameters garnered from user input or a previous installation. Click Install to continue; otherwise,
click Previous to change a value. [Console: Press Enter to continue; otherwise, type "back" and then
press Enter to change a value.]
9. Installing AccuRev -- The Installation Wizard displays a splash screen [Console: displays "Installing"
with a progress bar] while it installs the software on your local machine. It displays a Please Wait
message while it performs configuration tasks.
10. Configure: Start AccuRev WebUI Server -- In a new installation, the Installation Wizard prompts
you to start the AccuRev Web UI Server. Accept the default value (Yes) unless you want to start it
later. Click Next to continue. [Console: Press Enter to continue.]
11. Install Complete -- The Installation Wizard displays a message when the installation is complete.
Click Done to exit. [Console: Press Enter to exit.]

What to Do Next
The following table summarizes tasks you should consider performing after installing the AccuRev Web
UI Server. See also Tomcat Customization and AccuRev Upgrades.
Table 10. After Installing the AccuRev Web UI Server
Task

Comments

Start the Web UI Server.

You need to start the Web UI Server to make the AccuRev Web UI available to your users.
If you did not start the AccuRev Web UI Server during the installation process, see
Starting, Stopping, and Testing the AccuRev Web UI Server on page 37.

Test the Web UI

Before informing your users that the AccuRev Web UI is available, perform a simple test
to make sure that it is working as you expect.
See Testing the AccuRev Web UI on page 37.

Configure the Web UI Server to
make it accessible by IDE plugins for AccuRev.

AccuRev has plug-ins for numerous IDEs like Eclipse and Visual Studio. To be able to
access the AccuRev Web UI in these IDEs, you need to create a configuration file on the
AccuRev Web UI Server.
See Configuring the AccuRev Web UI on page 37.

Review advanced configuration
settings.

You can use a configuration file to change the default session timeout, provide access to
multiple AccuRev Servers, and more. These and other advance topics are described in the
AccuRev Web Interface Administrator’s Guide.
See Post-Installation Information on page 38.

Tomcat Customization and AccuRev Upgrades
The AccuRev Web UI uses the Tomcat web server. The following table shows what Tomcat version is
installed with what AccuRev version:
AccuRev Version
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Tomcat Version

7.1

8.0.47

7.0.1

8.0.43

7.0

8.0.33

6.1 through 6.2.3

7
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AccuRev Version
Pre-6.1

Tomcat Version
6

If you customized the Tomcat web server (e.g., by modifying the server.xml file) for an earlier release of
AccuRev and are now upgrading to AccuRev 7.1, you must migrate your Tomcat changes to the Tomcat
8.0.47 version that is installed with AccuRev 7.1.
To help you with this process, the upgrade install moves your previous Tomcat installation from the
<AccuRev_install>\WebUI\tomcat directory to <AccuRev_install>\WebUI\tomcat.old. You can
examine your old customizations in tomcat.old and make comparable changes in the tomcat directory.
If you have not customized Tomcat at all, you can safely remove the tomcat.old directory after the upgrade
install has completed.

Starting, Stopping, and Testing the AccuRev Web UI Server
Linux shell (.sh) and Windows batch (.bat) scripts are provided for stopping and starting the Tomcat web
server for the AccuRev Web UI:
<ac-install>/WebUI/tomcat/bin/[ startup | shutdown ].[ sh | bat ]

Testing the AccuRev Web UI
To test the AccuRev Web UI, open a browser and enter the following URL:
http://<webui-host>:8080/accurev

If this does not display an AccuRev login window, try restarting the AccuRev Web UI Tomcat server. See
Starting, Stopping, and Testing the AccuRev Web UI Server on page 37. If the Web UI appears as expected, you
can make this URL available to users to whom you want to provide access to the AccuRev Web UI.
Also, if you want to make the Web UI accessible through your users’ AccuRev GUI, you should ensure
that the AccuRev installation is included in their PATH setting. If they try to open the Web UI from the
AccuRev GUI (using the View > Open in Web choice on the AccuRev GUI menu, for example) and the
Web UI login screen appears but does not display a valid server to connect to, the PATH is probably not set
correctly.

Configuring the AccuRev Web UI
This section describes how to configure the AccuRev Web UI to make it available to:


The AccuRev GUI (some features in the AccuRev GUI make use of the Web UI)



AccuRev IDE integrations (like the Eclipse plug-in for AccuRev, for example)

You do this by creating a settings.xml file on the AccuRev Server as described in the following procedure.

Creating the settings.xml file
Instructions for creating this file are found in the AccuRev Installation and Release Notes for each
integration, but in summary:
1. Shut down any third-party packages.
2. Create a file called settings.xml in the <ac-install>/storage/site_slice/dispatch/config
directory.
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3. Edit the file to add the lines shown below (replacing <webui-host> with the actual name of the host
providing access to the AccuRev Web UI), and save it.
<settings>
<webui url="https://<webui-host>:8080/accurev"/>
</settings>

(If necessary, change the port from “8080” to the value in use at your site.)
Note: Refer to the installation and release notes for specific AccuRev integrations (Eclipse and Visual
Studio plug-ins, for example) for additional information specific to your third-party IDE.
4. Restart any third-party packages shut down in Step 1.

Post-Installation Information
See the AccuRev Web Interface Administrator’s Guide for post-installation configuration information.

Configuring Database Tuning Parameters
Use these instructions to set the database tuning parameters that will allow the database to make the best
use of your system resources. You should do this after installing AccuRev but before starting the server and
before running the maintain migratepg or migrate dbupgrade command.
1. Log in as <ac-user>.
2. Ensure that the database server is stopped using the procedures described in Starting and Stopping
AccuRev Servers on page 45.
3. To improve database performance you may elect to increase the amount of memory allocated
exclusively to PostgreSQL by editing <ac-storage>/db/postgresql.conf.


(non-Windows platforms) Note that editing postgresql.conf could also require you to alter part of
your operating system's kernel configuration and possibly reboot your system. Read the section
applicable to your operating system at http://www.postgresql.org/docs/9.5/static/kernelresources.html for more information.



shared_buffers –



effective_cache_size –

Change to 512MB or 25% of total physical memory installed on the machine
running AccuRev, whichever is less.
Set to 75% of free physical memory reported by the operating system
when both AccuRev and the database are stopped (see Starting and Stopping AccuRev Servers on
page 45).
Free physical memory can be estimated as follows:


UNIX/Linux (expressed in MB):
free -m | awk '/buffers.cache/{print $4}'
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Windows Server 2008/Windows 7 or later (expressed in MB): Access the Performance tab on
the Windows Task Manager. Use only the Available value under “Physical Memory”.



Other operating systems: You may be able to use the top command; refer to your operating
system vendor’s documentation.

Note: On 64-bit operating systems with more than 4GB of memory, the effective_cache_size
is not limited to 4GB, as it does not reflect memory allocated by PostgreSQL. This setting is an
estimate of the amount of memory available to the operating system for filesystem caching.
4. Start the AccuRev Database Server process according to the instructions in Starting and Stopping
AccuRev Servers on page 45.
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Using the ‘maintain dbupgrade’ Command
The maintain dbupgrade command is used to upgrade your existing AccuRev database after you have
upgraded your AccuRev server. This command is used when upgrading to any pre-7.0 release or when
upgrading from 7.0 or 7.0.1 to 7.1.
NOTE: Upgrading from a 5.7 or 6.x version to 7.0 or later requires the use of maintain migratepg instead
of maintain dbupgrade. See Upgrading a Server from a 5.7 or 6.x Version on page 26 for information
about maintain migratepg.
For 4.x databases (4.7 or higher), dbupgrade performs these tasks:


Performs validation and cleanup of 4.x metadata records.



Converts the metadata to UTF-8 for proper internationalization support.



Imports the metadata to the third-party database used with AccuRev 5.x.

For 5.0.1 and higher databases, dbupgrade upgrades the AccuRev database schema. (5.0.5 and 5.2
databases are already internationalized, so they do not require UTF-8 conversion.)
IMPORTANT: Before performing the dbupgrade operation, ensure that you have tuned your database as
described in Configuring Database Tuning Parameters on page 38, and have restarted your database so
that the tuning parameters take effect. Also ensure that you have left yourself an adequate window of time:
each dbupgrade run can take several hours, particularly if you are performing trial runs and upgrades on a
test machine that is not particularly fast.
You will be prompted to perform the dbupgrade process in two steps:
1. In "trial run" mode, to evaluate how the upgrade process will succeed.
2. In "force" mode, where your database will actually be converted.
See the "The ‘maintain’ Utility" chapter of the AccuRev Administrator’s Guide for more details about this
utility.

Performing a "Trial Run" Upgrade
To begin the upgrade process, change to the <ac-install> /bin directory and enter the following at the
command line:
maintain dbupgrade <db-admin-name>
You will be prompted for <db-admin-pass>, and then asked whether you want to run the upgrade as a

“trial run”, using a default codepage of “CP1252” (a superset of ISO-8859-1). Performing the conversion
as a trial run means that your database will not be changed, but you will be notified of any issues so you
can determine whether or not to repeat the upgrade in non-trial mode (and actually convert your database).
The codepage specification allows dbupgrade to attempt a reasonable conversion of your existing data to
UTF-8. The default CP1252 codepage (“Western European”), although considered as “Windows”
codepage, is a superset of ISO-8859-1 and is a reasonable starting point for both Windows and Linux
servers, especially in mixed environments. Only specify a different codepage if you know for certain that
you use a different one at your site.
When prompted whether or not you wish to proceed with a trial run, answer Y to perform the trial upgrade.
(N performs a real upgrade that will modify your data.)
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The upgrade process can take several hours, depending on factors such as your hardware, the size of your
database, system load, etc. All information is captured in the following log files:


<ac-storage>/site_slice/logs/dbupgrade.log



<ac-storage>/site_slice/logs/dbupgrade_i18n_report.html

If you make multiple dbupgrade runs, any existing log files are backed up with time-stamp names. It is
critical that you get a successful trial run, and review the logs for any problems prior to performing an
actual database upgrade. If you have any questions about the results, you should contact Micro Focus
SupportLine (https://supportline.microfocus.com).
See Understanding maintain dbupgrade Messages on page 41 for descriptions of messages that appear
during the upgrade.

Understanding maintain dbupgrade Messages
During the data migration, several AccuRev tables will be altered, resulting in some or all of the messages
described in this section.

Messages from maintain dbupgrade
When the upgrade completes successfully, a message like the following appears at the end of the output:
AccuRev 4.x to 5.x metadata migration completed without errors in 0.11
minutes.

*** The AccuRev database has been upgraded.
The AccuRev Server is ready to be started.

If errors are detected during the migration, a message similar to the one shown below will appear at the end
of the output:
AccuRev 4.x to 5.x metadata migration completed with errors in 0.11 minutes.

*** Errors were detected during the 4.x to 5.x metadata migration
processing.
See /opt/accurev/storage/site_slice/logs/dbupgrade.log for details.
The AccuRev Server WILL NOT start until the upgrade is successful.
Please contact AccuRev Service for assistance.

Additional details are available in the file <ac-storage>/site_slice/logs/dbupgrade.log.
See the following section, Messages from the dbupgrade.log File, for details on locating and interpreting
the reasons for any failures.
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Messages from the dbupgrade.log File
Note: Please store the <ac-storage>/site_slice/logs/dbupgrade.log file in a safe place. It contains
information that could assist AccuRev Support Services with troubleshooting any data migration or
database upgrade issues.
The dbupgrade.log file consists of log entries of the following severity levels, in ascending order:


INFO -- Status messages indicating what the dbupgrade utility is doing at a particular point in
time. The intended audience for this category of messages is primarily AccuRev Support Services.



NOTICE -- Messages that record information about the dbupgrade operation that might be of
interest to the user. Example: Translations of non-ASCII characters from CP1252 to UTF8 will be reported in C:/Program Files/AccuRev/storage/site_slice/logs/
dbupgrade_i18n_report.html



WARNING -- These messages indicate that maintain dbupgrade encountered an issue that may
require your attention but does not necessarily constitute a reason to fail the data migration/
upgrade. You must evaluate any WARNING messages and determine if you can proceed with the
results of the dbupgrade operation. See the examples and additional information in Warning
Messages on page 42.



FATAL -- These messages indicate that maintain dbupgrade encountered a serious problem that
prevented it from completing. You must address any FATAL issue (usually with the help of
AccuRev Support Services) and rerun dbupgrade before proceeding.

As an end-user, you should only be concerned with WARNING and FATAL entries.

Warning Messages
Warning message example #1:
0 Unable to find storage location for depot: depot_name: /path-to-storage/depots/
depot_name
-Error- 1 - prj.c:211 - Unable to initialize depot - System Error: 2 No such file or
directory
WARNING: Depot 'depot_name' skipped: Unable to initialize: No such file or
directory: OS error: see above

Explanation:
Ensure that the depot is supposed to still be active, and that the data for the depot is actually present on the
system. You may need to use either the chslice or rmdepot AccuRev commands to remedy the problem.
This condition is most likely to occur during a trial run on a test machine (as opposed to "in-place" -- see
Performing a Trial Upgrade on a Test Machine on page 18.)
Warning message example #2:
WARNING:
WARNING:
WARNING:
WARNING:
WARNING:
WARNING:
WARNING:
WARNING:

Would migrate site... FAILED
Would migrate depot 'depot_name'... FAILED
Migrating site... FAILED
Migrating depot 'depot_name'... FAILED
Would upgrade site... FAILED
Would upgrade depot 'depot_name'... FAILED
Upgrading site... FAILED
Upgrading depot 'depot_name'... FAILED

Explanation:
One or more errors have occurred which prevented the site slice/depot in question from being migrated or
upgraded. One or more corresponding log entries with severity FATAL should be present in
dbupgrade.log prior to this WARNING entry, with the specific reasons for the errors.
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Warning message example #3:
WARNING: AccuRev 4.x to 5.x metadata migration trial run completed without errors in
X minutes. *** The AccuRev Server WILL NOT start after the migration trial run.

Explanation:
You have successfully completed a trial migration from AccuRev 4.x to 5.x, but you must analyze the
results and re-run the migration “for real” in order for the AccuRev Server to start. You must now review
the dbupgrade_i18n_report.html file for correctness (see the "Messages from
dbupgrade_i18n_report.html on page 44"). Then, if all highlighted characters in
dbupgrade_i18n_report.html are correct, proceed to perform the actual migration as described in
Performing the Actual Database Upgrade on page 45. Test your installation. If you were doing the
upgrade on a test machine, return to Performing an Upgrade "In Place" on page 19 to complete the
upgrade on your production machine.
Warning message example #4:
WARNING: Would change database encoding to UTF-8: cannot proceed any further without
making changes to the database, stopping
WARNING: Would create a UTF-8 case-insensitive index: cannot proceed any further
without a UTF-8 database, stopping
WARNING: AccuRev database upgrade trial run completed without errors in X minutes.
*** No changes were made to the database during the upgrade trial run.

Explanation:
You are performing a trial upgrade from 5.0.x/5.1 to 6.2, which adds internationalization (I18N) support.
Everything up to the point where the database is switched to UTF-8 has completed successfully, but the
actual switch cannot occur during a "trial" run. You must now review the dbupgrade_i18n_report.html
file for correctness (see Messages from dbupgrade_i18n_report.html on page 44). Then, if all highlighted
characters in dbupgrade_i18n_report.html are valid, proceed to perform the migration "for real" (see
Performing the Actual Database Upgrade on page 45, and Upgrading an AccuRev Server from 5.0.x on
page 20 or Upgrading a Server from a 5.7 or 6.x Version on page 26.)

Fatal Messages
Fatal message example #1:
FATAL: AccuRev 4.x to 5.x metadata migration completed with errors in X minutes. ***
Errors were detected during the 4.x to 5.x metadata migration processing. See /pathto-/dbupgrade.log for details. The AccuRev Server WILL NOT start until the upgrade
is successful. Please contact AccuRev Service for assistance.
FATAL: AccuRev database upgrade completed with errors in X minutes. *** Errors were
detected during the database upgrade processing. See %s/%s for details. No changes
were made to the database. Please contact AccuRev Service for assistance.

Explanation:
One or more errors have occurred which prevented the migration or upgrade from completing. Additional
log entries with severity FATAL should be present in dbupgrade.log with the specific reasons for the
errors.
Fatal message example #2:
FATAL: File not found - /path-to-storage/depots/depot-name/table-name.ndb

Explanation:
You are migrating from 4.x to 6.2 and the 4.x ndb file in question cannot be found. If the file is part of a
depot that is no longer active, you may want to first rmdepot depot-name in 4.x, then retry the migration.
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Fatal message example #3:
FATAL: Depot contains AccuWork issues, but the corresponding schema.xml definition
could not be found or loaded

Explanation:
The AccuWork schema.xml file is missing from the
<ac-storage>/depots/depot-name/dispatch/config directory.

Fatal message example #4:
FATAL: Database error: ...
FATAL: Retrieving list of depots from database: Database error: ...
FATAL: table 'X' rowcount mismatch: expected Y, got Z
FATAL: LOC width X not supported!

Explanation:
If you receive any of these errors, contact Micro Focus SupportLine (https://supportline.microfocus.com).

Messages from dbupgrade_i18n_report.html
Note: Store the <ac-storage>/site_slice/logs/dbupgrade_i18n_report.html file in a safe place. It
contains information that could assist AccuRev Support Services with troubleshooting any data migration
or database upgrade issues.
The information in dbupgrade_i18n_report.htm contains the results of the UTF-8 conversion based on the
code page that you specified. Open this report in a web browser and look for any highlighted characters -these represent non-ASCII characters found during the conversion.
Some highlighted characters can be ignored. For example, accents and umlauts may have been introduced
when adding a foreign document to the depot. Likewise, some highlighted characters may be simple nonASCII punctuation characters like em dashes (“—”). However, if a highlighted character does not look
valid, it probably needs to be corrected.
To research the origin of suspect entries, use the information in the report to find the characters in your
existing, running AccuRev installation (4.x, 5.0.x, or 5.1):
1. Click on the triangular handle next to any highlighted entry to see where it is being referenced (depot,
stream, etc.). For example, in the illustration below, clicking on the handle next to “Stream name”
reveals that two non-ASCII characters appear in the stream name that begins “LINE tests bld”.
Clicking on the handle for this entry narrows down the location to depot_id 13 and stream_id 2802.

2. Use the displayed information (depot_id, stream_id, issue_num, etc.) to navigate to the suspect entry
in your existing (4.9, 5.0.x, or 5.1) AccuRev UI.
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3. Compare the appearance of the suspect entry in the report against how it appears in your existing
AccuRev installation.
Here are some general rules for interpreting these results:


All highlighted characters are correct. Your data will convert cleanly, and you can proceed to
perform the actual upgrade without a trial run:
maintain dbupgrade -f -E CP1252 <db-admin-name>

(Note: Use the exact same maintain dbupgrade command on the replica servers, if any.)


Some highlighted characters are incorrect. Determine whether or not these characters are
acceptable, or if you can fix them after the upgrade. For example, you might be able to rename a
stream or a file. Note: Because of AccuRev’s TimeSafe® feature, snapshots and time-based streams
will preserve the pre-rename, incorrect information.) If in doubt about how to proceed, please contact
Micro Focus SupportLine (https://supportline.microfocus.com).



There are many incorrect highlighted characters and the problem seems to be consistent. If you
can identify a recurring, common problem, you probably need to use a different code page. For more
information about code pages, start with http://en.wikipedia.org/wiki/Character_encoding.

Performing the Actual Database Upgrade
Once you have fixed any issues reported by the "trial run" upgrade, you can perform the actual database
upgrade by re-running the maintain dbupgrade command as described in the previous section, but
responding N when prompted whether or not you wish to run in trial mode, and confirm your choice.

Starting and Stopping AccuRev Servers
This section describes the procedures you can use to start and stop the AccuRev Server and the AccuRev
Database Server.

Starting and Stopping the AccuRev Server
Use the procedures below to start and stop the AccuRev Server.
Starting
Platform
Windows

UNIX/Linux

Interface

Start Procedure

GUI

Services window > Locate service, right-click, choose Start Service

Command line

net start accurev

Command line

cd <ac-install>/bin
./acserverctl start

Stopping
Platform
Windows

UNIX/Linux

Interface

Stop Procedure

GUI

Services window > Locate service, right-click, choose Stop Service

Command line

net stop accurev

Command line

cd <ac-install>/bin
./acserverctl stop
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When you start the AccuRev Server, the database is automatically started first.

Starting and Stopping the AccuRev Database Server
Use the procedures below to start and stop the AccuRev Database Server.
Starting
Platform
Windows

UNIX/Linux

Interface

Start Procedure

GUI

Services window > Locate service, right-click, choose Start Service

Command line

net start "accurev db server"

Command line

cd <ac-install>/bin
./acserverctl dbstart

Stopping
Platform
Windows

UNIX/Linux

Interface

Stop Procedure

GUI

Services window > Locate service, right-click, choose Stop Service

Command line

net stop "accurev db server"

Command line

cd <ac-install>/bin
./acserverctl dbstop

When you stop the AccuRev Database, the AccuRev Server is automatically shut down first.

Starting and Stopping the AccuRev Tomcat Server and Mosquitto
MQTT Message Broker
Use the procedures below to start and stop the AccuRev Tomcat Server and Mosquitto MQTT Message
Broker.
Starting
Platform
Windows

UNIX/Linux

Interface

Start Procedure

GUI

Services window > Locate service, right-click, choose Start Service

Command line

net start AccuRevTomcat
net start "AccuRev Mosquitto"

Command line

For Tomcat:
<ac-install>/WebUI/tomcat/bin/startup.sh
install>/storage/site_slice/logs/
accurev_tomcat_startstop.log 2>&1 &

>> <ac-

For Mosquitto:
cd <ac-install>/mosquitto
./mosquitto --daemon -c ./mosquitto.conf >> <acinstall>/storage/site_slice/logs/mosquitto.log 2>&1 &
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Stopping
Platform
Windows

UNIX/Linux

Interface

Stop Procedure

GUI

Services window > Locate service, right-click, choose Stop Service

Command line

net stop AccuRevTomcat
net stop "AccuRev Mosquitto"

Command line

For Tomcat:
<ac-install>/WebUI/tomcat/bin/shutdown.sh
install>/storage/site_slice/logs/
accurev_tomcat_startstop.log 2>&1 &

>> <ac-

For Mosquitto:
pkill -x mosquitto

Summary of Start and Stop Operations
In summary:


Starting the AccuRev Server will automatically start the AccuRev Database if it is not already
running.



Stopping the AccuRev Server will NOT automatically stop the AccuRev Database.



Starting the AccuRev Database will NOT automatically start the AccuRev Server.



Stopping the AccuRev Database will also stop the AccuRev Server, but only if you say "Y" to the
prompt. Otherwise, neither will be stopped.

See "Controlling Server Operation" in the AccuRev Administrator’s Guide for more information, and for
setting up your system to automatically start the AccuRev processes at boot time.

Platform Support Notes
The following sections contain important information about installing AccuRev software on specific
hardware/software platforms.

Platform Support Matrix
For the most up-to-date list of supported platforms, go to http://supportline.microfocus.com/
supportresources/AccurevSupportMatrix.aspx.

Important Notes:
1. The Platform Support Matrix lists the platforms that have been tested for the AccuRev 7.1 server and
client. We will investigate and attempt to address issues reported on other platforms, but we reserve the
right to request that you reproduce the problem on a supported platform.
2. We will investigate and attempt to address issues reported on virtualization platforms not supported by
AccuRev, but we reserve the right to request that you reproduce the problem on one of the supported
OS platforms listed in the Platform Support Matrix, running in a non-virtualization environment.
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Java Compatibility
AccuRev 7.1 is compatible with the Java 2 Runtime Environment (JRE), Versions 1.8.0_152 and higher.

(UNIX/Linux only) Workaround for Java Runtime Library Problems
The AccuRev Installation Wizard and the AccuRev GUI fail on some UNIX/Linux platforms because of
Java library problems. Use this procedure to work around these problems:
1. Run the Installation Wizard with environment variable LIBXCB_ALLOW_SLOPPY_LOCK set to the
value 1.
2. Fix the runtime library file in the new AccuRev installation area:
> cd ac-install/jre/lib/i386/xawt
> sed -i 's/XINERAMA/FAKEEXTN/g' ./libmawt.so

Linux


PostgreSQL may fail to function properly when SELinux mode is set to “Enforcing”. See http://
docs.fedoraproject.org/en-US/Fedora/13/html/SELinux_FAQ/#id2963608 for more information. To
find out the current SELinux mode run getenforce (as root). To set SELinux mode to “Permissive”,
run setenforce PermissiveEdit.



Linux systems require glibc version 2.4 or higher. To determine your glibc version, run
rpm -qi glibc in a command shell. Ubuntu systems require libc6-i386.



The AccuRev Installation program and the AccuRev GUI fail on some older UNIX/Linux platforms
because of Java library problems. Use this procedure to work around these problems:


Set the environment variable LIBXCB_ALLOW_SLOPPY_LOCK to the value 1.



Run the installation program.



Fix the runtime library file in the new AccuRev installation area:
> cd <ac-install>/jre/lib/i386/xawt
> sed -i 's/XINERAMA/FAKEEXTN/g' ./libmawt.so

AIX


Only the AccuRev client software is supported on this platform.



You cannot upgrade the AccuRev Client using the Help > Upgrade Client menu choice.



If you use the console method to upgrade your AccuRev Client, the response file is not read; you must
provide values for host, port, and path when prompted.



The following shared libraries must be accessible, both by the AccuRev Installation Wizard and by the
installed AccuRev executables. The pathnames below show typical locations for these shared libraries.
/usr/freeware/lib/libcrypto.a
/usr/freeware/lib/libintl.a
/usr/lib/libc.a
/usr/lib/libcrypt.a
/usr/lib/libdl.a
/usr/lib/libpthread.a
/usr/lib/libpthreads.a
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Note: It is recommended that the LIBPATH environment variable not be set, as it can interfere with the
loading of libraries from /opt/accurev/bin.
The libraries above are typically part of the following AIX filesets and/or open-source RPM packages:





bos.loc.utf.EN_US (or any other non-EN_US UTF locales)



bos.rte.bind_cmds



bos.rte.libc



bos.rte.libpthreads



bos.rte.security



openssl-0.9.7X



gettext-0.17-1 (or later)



AIX 5.3: fix pack 5300-07 or newer required



AIX 6.1: fix pack 6100-GOLD or newer required



AIX 7.1: fix pack 7100-GOLD or newer required

The installer mistakenly warns you that you have not chosen the bundled JRE. Complete the
installation, then change this setting in /opt/accurev/bin/acgui.lax:
lax.nl.current.vm=../jre/bin/java

Solaris


The AccuRev Server and Client are supported on Solaris x64.



If you upgrade the AccuRev Client using the console mode, you are not prompted to provide values for
host, port, and path. AccuRev uses values from your existing AccuRev Client installation to perform
the upgrade.



The following shared library must be accessible, both by the AccuRev Installation Wizard and by the
installed AccuRev executables. The pathname below shows the typical location for this shared library.
/usr/sfw/lib/libgcc_s.so.1

Note: It is recommended that the LD_LIBRARY_PATH environment variable not be set, as it can
interfere with the loading of libraries from <ac-install>/bin.
The library above is typically part of the following SUN package:


SUNWgccruntime

Restrictions on the Use of AccuRev Clients in Solaris Zones
The following restrictions apply to the use of AccuRev clients in Solaris zones:


The AccuRev Server should be run from a global zone. If you want to run an AccuRev Server from a
non-global zone, you should give that zone a private disk volume and not use a loopback mount to the
global zone for any of the AccuRev Server metadata or storage files.



Workspaces can only be created on zones with private host names.



Workspaces in the non-global zone cannot be used from the global zone.
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Workspaces on NFS mounts (not recommended) must be NFS-mounted directly from the non-global
zone, not through a loopback mount in the non-global zone to an NFS mount in the global zone.

•

Solaris requires operating system patches, as described on the Oracle Technology Network
(http://www.oracle.com/technetwork/systems/patches/index.html).

Windows


Disable anti-virus checking for the <ac-storage> directory and all directories beneath it to avoid
performance problems associated with anti-virus checks.

Mac OS X


AccuRev Release 7.1 supports only the AccuRev client software on the Mac OS X platform.



The following is a recommended method for getting all required executables into the PATH for Mac
OS X:
Create the following three files using "sudo":
sudo echo "/Applications/AccuRev/bin" > /etc/paths.d/AccuRev
sudo echo "/Applications/AccuRev/bin/acdiffgui.app/Contents/MacOS" >
/etc/paths.d/Acdiffgui
sudo echo "/Applications/AccuRev/bin/acgui.app/Contents/MacOS" >
/etc/paths.d/Acgui



To enable the AccuRev diff GUI tool (acdiffgui) to work stand-alone as well as from an IDE
integration such as Eclipse, do the following:
1. Make a backup copy of acdiffgui:
cd /Applications/AccuRev/bin/acdiffgui.app/Contents/MacOS
mv acdiffgui acdiffgui.orig

2. Create a new acdiffgui file with the following content:
#!/usr/bin/perl
my $acbin = '/Applications/AccuRev/bin';
my @jars = qw(oro.jar xercesImpl.jar xml-apis.jar fw.jar werken.opt.jar diff.jar
accurev-common.jar);
my $cp = join(':', map {"$acbin/$_"} @jars);
my @args = ('java', "-Duser.dir=$acbin", '-Xms32M', '-Xmx512M', '-classpath', $cp,
'diff.DiffApp', @ARGV);
system (@args);

3. Create the following link:
ln -s /Applications/AccuRev/bin/acdiffgui.app/Contents/MacOS/acdiffgui
/Applications/AccuRev/bin/acdiffgui

4. Close any shells.
5. Open a new shell.
Running acdiffgui should now bring up the AccuRev graphical diff tool, and it should also work
from within any integrated IDE.
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Uninstalling AccuRev
On Windows, we recommend that you run <ac-install>\bin\UninstallerData\Uninstall
AccuRev.exe to ensure that the AccuRev services and registry entries are removed cleanly. Back up and
remove any folders and files left under <ac-install>.
On UNIX/Linux, simply halt and remove any AccuRev services, and back up and remove any folders and
files left under <ac-install>.
Note: If you are planning to upgrade either your AccuRev client or your AccuRev server, we recommend
that you not uninstall AccuRev. Instead, just install over the existing AccuRev content.
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AccuRev 7.1 Release Notes
This chapter describes changes and other information related to AccuRev 7.1.
Notes:


To ensure AccuRev’s successful installation and optimal performance, install all applicable
updates for your operating system before installing or upgrading AccuRev.



If you are upgrading from an earlier release, we recommend that you install 7.1 over the existing
AccuRev content.

Deprecated Platforms
No platforms have been deprecated in AccuRev 7.1.

Changes in AccuRev Release 7.1
AccuRev Release 7.1 includes the following new features and bug fixes.
Note: In cases where an issue is identified with two numbers, such as 10721 (1098410), the first
number is the issue number in the AccuWork issue tracking system, and the second, in parentheses, is
the issue number in the SupportLine system used by Customer Care.
7071 - "hist -t" often returns transactions outside the -t bounds
hist -t now returns the set of transactions that are within the specified boundaries and does not include any
transactions outside those boundaries.
13165 (1096984) - RFE: Add "pop"option to specify EOL terminators when copying
elements to a non-workspace location
The pop -v -L command now supports two new options, --eol=unix and --eol=windows, which allow the
user to specify what kind of line endings to use when copying a version of an element into a nonworkspace location.
22438 - GUI: Incorrect information is displayed for date interval in Show History of a
stream
hist -t now returns the correct set of transactions when the user gets a stream history within a specified date
interval and then changes one of the dates in that interval.
27702 (1098155) - Bulk merge tool should not convert EOLs in file to platform-specific EOL
Prior to Release 7.1, a bulk merge of files that contained only trivial merges automatically converted all
end-of-line sequences to the platform-specific end-of-line sequence. This conversion is no longer done in
7.1.
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34585 (1095258) - Add a recursive switch for a directory history
The hist command has a new -R option, which displays the history of transactions that affect the specified
folder and all files and folders in the subtree beneath it.
36319 (1096259) - WebUI does not display stream colors
The WebUI now correctly displays stream colors that have been configured by setting the "streamStyle"
stream property.
41045 (1104197) - RFE: GUI: A way to limit the number of active transactions displayed for
a stream
A GUI user can use a new dropdown in the Active Transactions default group and tab to select the number
of active transactions (20, 50 or 100) or the number of months of active transactions (1, 3, or 6) to display.
The user can also elect to show all active transactions by choosing "Everything" in the dropdown.
41126 (1095129) - GUI: Allow ESC from pop-up window
The Find and Format Columns dialog boxes can now be closed by hitting the ESC key.
44107 - RFE: GUI: Add ability to sort items in the Workspace Explorer by file extension
The Workspace Explorer mode of the File Browser view now has a column called "Extension", which
displays the extension of file names. Sorting in either direction can be done on this column.
44137 - ACLs should not block diff/merge/annotate with version from an access-restricted
stream
As of Release 7.1, a user can perform diff, merge, and annotate operations on files even if ACLs restrict the
user’s access to streams containing ancestor versions that are involved in the operations.
44139 - RFE: GUI displays aliases for servers instead of their IP addresses and host
names
From the GUI login dialog, the user can now edit a server and define an alias for it. That alias will be
displayed instead of the server’s IP address and hostname in the GUI’s list of available servers.
44187, 47314 - RFE: GUI/WebUI: Ability to specify search values dynamically at the time of
query execution
When defining an issue query in either the GUI or WebUI, the user can mark one or more query fields as
"dynamic". This is done by (a) optionally specifying a default value for the field, and (b) checking the
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field’s checkbox labeled "Dynamic". Then, when the query is executed, the user will have the opportunity
to change the value of all the query’s dynamic fields before the query actually executes.

44266 (1107583) - WebUI: Created or modified issue query fails to retain selected entries
The WebUI now correctly stores issue queries that contain multiple clauses for the same user-type field.
44415 (1107786) - EACL: Failure to set eacl when there are duplicate files/directories listed
in input file
The eacl command now functions properly even if its input file contains duplicate entries for an element
(file or directory).
46495 (1109762) - GUI: Editing a user takes several minutes to display the Edit User dialog
In the Admin => Security tab, the Edit User dialog opens much more quickly now due to use of a faster
algorithm for finding the groups to which the user belongs.
46621 (1096036, 1100809) - RFE: Save acclient.cnf file in a location that is accessible to
non-admin users in Windows
The AccuRev install process places a template for acclient.cnf into the <ac-install>/bin folder, and the
AccuRev 7.1 GUI then copies that file into each user’s %ACCUREV_HOME%/.accurev folder. Placing the
file in this folder enables modifications by non-admin users.
46653 - RFE: GUI: Add support for new Clone relationship type
Release 7.1 supports a new type of relationship called Clone in the Schema Editor. It is now possible to
add a field of Relationship type Clone to the schema. This enables users to see in AccuWork what issues
were created as clones of other issues.
46785 - RFE: Support client auto-upgrade via custom MSI, etc.
The client upgrade command, available via Help > Upgrade Client in the GUI or "accurev
upgrade_client" on the command line, now supports custom-created installers such as Windows MSI
files. Administrators must deploy their custom installers on the AccuRev server machine in the folder <acinstall>/bin/installers/<OS>, alongside the standard AccuRev installers, and then add corresponding
entries to the acserver.cnf file.
Note: This feature works only with clients running AccuRev 7.1 or later. Clients running older
versions of AccuRev cannot use custom installers.
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For each custom installer, the administrator must add a line of the following format to acserver.cnf:
<OS>_INSTALLER=<installer>

where <OS> is one of the following: WIN, LINUX, SOLARIS, MAC
As an example, to make the AccuRev server use an MSI file called OurCustomerINST.msi, add this line to
acserver.cnf:
WIN_INSTALLER=OurCustomerINST.msi

Do not specify the full path; the MSI file must be located in the <ac-install>/bin/installers/Windows or
Windows64 folder.
If the file specified in a custom installer entry does not exist, the AccuRev server will look for the default
AccuRev installer (AccuRevClientInstaller) appropriate for the operating system.
If a custom installer requires command line parameters, they can be specified in a second entry in the
acserver.cnf file, using this format:
<OS>_INSTALLER_PARAMS=<parameters>

Note that these changes to acserver.cnf can be made without stopping the AccuRev Server service. The
AccuRev Server checks the file for these installer entries each time that a client upgrade is performed.
46793, 46883 - GUI, WebUI: Show all relationship changes in Issue History
Changes in issue relationships are now tracked in AccuWork’s Issue History tab and are visible in both the
GUI and WebUI issue displays.
46928, 47061, 47539 - GUI: Display an issue field’s label, if it exists, instead of the field
name
The AccuRev GUI now displays issue field labels instead of issue field names in the Query Editor,
AccuWork’s Issue History tab, and in the Schema Editor’s Validation tab and New/Edit Promote Trigger
dialog.
47015 - WebUI should export Display Property of User-type fields in query results
Query results exported by the AccuRev 7.1 WebUI now use the configured Display Property for user-type
fields instead of the AccuRev user name. For example, if the schema defines the Display Property for the
"Assigned To" field to be the user’s email address, then the "Assigned To" column in the exported query
results will list email addresses for all users that have one defined, and it will list the AccuRev user name
for users that do not have an email address.
47313 - RFE: GUI: Export issue attachments when issue query results are exported
The GUI can now export issue attachments when exporting issue query results. If an Attachments-type
field is configured as a column in the query results table and an issue has attachments in that field, then
after the results table is exported, a "Save Attachments As" dialog prompts the user to save an archive of
all issue attachments. If the user accepts or edits the name of the archive, the attachments are exported as a
zip archive, sorted by issue. This is an optional step of the Export Table operation -- if the user clicks
Cancel in the dialog, the Export operation completes successfully and opens the exported table. This
applies to all export types (html, xml, csv).
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47317 - Update the scripts delivered in the accurev/extras/unix folder
The scripts installed on the AccuRev server in accurev/extras/unix have been updated, and new scripts
have been added. All the scripts now will su(1) prior to starting or stopping any of the AccuRev processes
that the script runs. The updated contents of accurev/extras/unix are:


accurev - AccuRev Server startup, where the server can be an AccuRev Master, AccuRev Replica, or
AccuRev Remote License Server



accurev_mqtt - AccuRev Mosquitto service / Message Queue Telemetry Transport (MQTT)



accurev_replica - AccuRev Replica: Creates AccuRev login sessions, possibly via an SSH tunnel or
your own custom configuration. Used in conjunction with the accurev script.



accurev_web - AccuRev Web Service



accurevSetLinks - Script to create links in /etc/init.d to start and stop the above processes. See the
documentation in this file for instructions on how to use this script.



README - General documentation



acserver.cnf-ssh and acserver.cnf-notSecure - Example reference files to aid in configuring an
AccuRev Replica when using the accurev_replica script

47593 (1111427) - GUI: Diff/Merge must honor file’s type (text/ptext) and not probe file to
see if its contents are binary
The GUI no longer displays a warning message "Unable to diff binary files" when a user tries to diff a
ptext file that contains binary content. AccuRev 7.1 allows the user to diff binary files.
47935, 48107 - GUI: Diff/Merge enhancements
The following diff/merge enhancements have been made in Release 7.1:


diff of image files is supported.



If a third-party diff tool is configured, binary file diff is enabled.



BeyondCompare v3 and v4 are supported on Windows, Linux, and macOS.



Araxis is supported on macOS.



TkDiff no longer has to be located in the AccuRev bin directory.



Preferences for custom third-party diff or merge tools are now sticky, allowing the user to switch back
and forth between tools without losing their configuration.

47961 - Upgrade the Tomcat version used by the WebUI
The AccuRev 7.1 WebUI is installed with and runs on Tomcat 8.0.47.
48092 - Add transaction values to client-side pre-promote trigger
Transaction IDs are now passed to the pre-promote trigger when a user executes a Promote By Transaction
operation.
48365 (1112125) - GUI: Refresh View does not refresh Stream Browser
This defect has been fixed, and Refresh View correctly refreshes the Stream Browser view now.
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Corrections and Changes to the Documentation
Please note the following corrections and changes to the AccuRev 7.1 documentation:
47191 - DOC: Installation Notes: Update Mac OS X section about running acdiffgui on Mac
In the "Mac OS X" section of the Installation Notes, accurev-common.jar has been added to the jar file list
in the perl script for running acdiffgui on Mac platforms.

Known Issues
This section describes known issues in AccuRev and in the AccuRev Web UI.
Installation on Windows with User Account Control (UAC) enabled displays confusing
dialog
If installation of the AccuRev 7.1 server or client is attempted on a Windows system while User
Account Control (UAC) is enabled, the installer will open a "User Account Control" dialog that
displays the program name as "Micro Focus International plc" instead of the name of the AccuRev
installer executable. The user can safely click on the Yes button to continue with the AccuRev
installation.
Switching servers in GUI stops display of notification badges
If a user switches the GUI from one AccuRev server to a different AccuRev server (via Tools =>
Login...), notification badges will no longer be displayed.
Workaround: Instead of using Tools => Login... in the GUI to switch from server A to server B, take
the following steps:
1. Exit the GUI instance that is connected to server A.
2. Execute accurev logout from the command line to terminate the session with server A.
3. Start the GUI and login to server B.
WebUI export of issue query results generates incorrect XML
If any of the exported issue fields have labels that contain spaces, then the XML generated by the
WebUI will be incorrectly formatted, and the query results will not display correctly in a browser.
Workaround: Edit the generated XML and change all spaces in issue field labels to underscores. For
example:
Original XML:
<?xml version="1.0" encoding="UTF-8"?>
<table>
<Issue>
<Issue>38747</Issue>
<Assigned To>John Moore</Assigned To>
<Short Description>Sorting is done on wrong field</Short Description>
</Issue>
</table>

Edited XML:
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<?xml version="1.0" encoding="UTF-8"?>
<table>
<Issue>
<Issue>38747</Issue>
<Assigned_To>John Moore</Assigned_To>
<Short_Description>Sorting is done on wrong field</Short_Description>
</Issue>
</table>
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AccuRev 7.0.1 Release Notes
This chapter describes changes and other information related to AccuRev 7.0.1.
Note: To ensure optimal performance, install all applicable updates for your operating system.

Deprecated Platforms
The following platforms are deprecated in AccuRev 7.0.1 and will not be supported in the next release of
AccuRev:


Linux Red Hat Enterprise 5



Linux Ubuntu 12, 13



Linux Fedora 23, 24

What’s New in AccuRev Release 7.0.1
Highlights of the exciting new developments in AccuRev 7.0.1 are captured here.

Version Browser: Highlighted Version Relationships and
Show Promotion Path
The Version Browser has been enhanced with two new features to help the user visualize the flow of
changes in the system: (1) highlighting of version relationship lines, and (2) the new Show Promotion
Path operation.
When the user clicks on a version to select it, the Version Browser now highlights the box representing that
version and all lines leading directly from earlier versions to the selected version. The highlighted lines
are drawn with a heavier weight line, but still in the appropriate color to identify the type of relationship.
Two examples showing highlighted relationship lines follow:
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Show Promotion Path is a new operation available in the context menu of versions that were created by a
Promote or Demote operation. Show Promotion Path uses a solid orange line to display the sequence of
promotions and demotions leading from a real (kept) version all the way to the selected virtual version. For
example:

AccuRev will draw a horizontal line going off the left edge of the window if the left endpoint version is not
displayed (due to the current transaction range or swim lane choices). If streams in the promotion path
have been filtered out of the version browser display (causing the promotion path line to be discontinuous),
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AccuRev will display a dialog telling the user which streams to add to the display in order to see the full
promotion path:

The user can clear the promotion path from the display by doing one of the following:


clicking Refresh View



changing the transaction range



executing Show Ancestry



clicking on a different stream in the bottom panel of the version browser

Scrolling around the panel or dragging versions around the display will not make the promotion path
disappear. This allows the user to move versions around to clarify the display.

Sync Stream Wizard in the GUI
When a stream’s time basis is modified, there may be newly visible changes in the backing stream that
need to be merged with the changes in the time-based stream. The new “Sync Stream wizard” in the GUI
takes care of this situation by running rebase and merge operations to sync the stream with its backing
stream. This wizard is invoked automatically when the user changes a stream’s time basis in the Stream
Browser. It can also be invoked manually on any stream by clicking the Sync button in the File Browser
view.
The Sync Stream wizard first runs the rebase command to resolve elements with (member) and (underlap)
status. If the stream contains any files with (overlap) status, the wizard then executes the merge command,
resolving any merge conflicts in a workspace that is selected by the user. Autokeep is automatically
enabled, so trivial conflicts are resolved and kept without requiring user input. As its final step, the wizard
prompts the user to promote all the resolved conflicts from the workspace up to the stream.
The initial screen of the Sync Screen wizard looks like this:
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Styling Individual Issue Fields in the Schema Editor
Previous releases of AccuRev provided limited abilities to style AccuWork issues – the administrator
could only specify the colors to be used for all field labels, required field labels, and the issue background.
Release 7.0.1 enables more extensive styling of individual issue fields. Depending on the type of the issue
field, it may be possible to specify the font style and foreground color for the field label and the field value,
as well as the background color for the field value. For certain types of fields, the width and height of the
value can be specified too.
Styling of an issue field is done in the new Style subtab of the Schema Editor’s Schema tab. The Restore
Default Styling button gives the user the option of returning to the default styling parameters for the
current issue field.
The following screenshots depict how one might style the “Title” issue field and the resulting appearance
of the field:
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Crucible Connection in the GUI
The AccuRev GUI now supports integration with Atlassian Crucible servers via a new AccuRev feature
called Crucible Connection. This integration improves developer productivity and alleviates performance
issues native to the Atlassian Crucible server related to creating and modifying code reviews using the
Crucible web browser and accessing the web application. By using the REST API provided by the
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Crucible application and the AccuRev Plugin for Crucible, the AccuRev GUI can now integrate with
Crucible by using HTTP and secure HTTPS connections (i.e., TLS v1.2).
Note: Crucible Connection works with Crucible 4.1.2 using AccuRev Plugin for Crucible version
2017.1. The AccuRev Plugin for Crucible must be installed as a managed add-on for the Crucible server
in order for Crucible Connection to work properly; the plugin allows Crucible to interact with the AccuRev
server.
To enable the Crucible Connection feature, enter Crucible server and user information in the Code Review
panel of the AccuRev GUI’s Preferences dialog. If the “Enable code review integration” checkbox is
selected, the GUI displays new menu items in various views to send active file changes, transactions, and/
or issues to “New Reviews” and “Existing Reviews." Crucible project and review information is retrieved
from the Crucible server and is filtered in the GUI based on the depot that is active in each AccuRev view.

Archive Enhancements
Release 7.0.1 introduces two new convenient ways of dealing with files that either need to be archived or
have already been archived. The first helps to identify which files the user would benefit most from
archiving, and the second provides a mechanism by which the AccuRev server can access an archived file
without actually unarchiving it.

Identifying Which Files to Archive
An administrator who wants to free up disk space can execute the maintain verinfo command on the
server to identify which files to archive. Each time a file is modified and kept, a new version of that file is
created and stored on the server in a “storage container file.” The verinfo command indicates, for each
element on the system, how many different, unarchived versions of the element are currently in storage and
the total amount of space occupied by all of those storage container files. The results are sorted in
descending order of amount of space occupied; therefore, the best candidates for archiving (i.e., those
whose storage containers use the most disk space on the server) are returned first.
The verinfo command is also available on the client side via accurev verinfo. This enables administrators
to issue the verinfo command from any client machine instead of having to login to the AccuRev server
machine.

Accessing an Archived File
Sometimes a storage container file that has already been archived is required again. A user might want to
patch an old issue that requires that container file, or perhaps he just wants to see how that file changed
over time using annotate or diff. Whatever the reason, he needs a way to gain visibility to the content that
was in the archived file.
The unarchive CLI command could be used to restore the archived storage container file to its original
location in the depot’s file storage area. However, the container file’s status would change from archived
to normal, and the user might then need to re-archive the file if he no longer needed it.
Release 7.0.1 offers a simpler alternative – a new trigger called server_archFiles_trig, which provides a
way to access an archived file on an as needed basis, without unarchiving the file. When installed, the
trigger gets called whenever a container file is missing from the depot’s storage location. The trigger is
passed the name of the depot and the file being accessed, along with the file’s original storage path. The
trigger can be written to access the data directly from the archive location and copy that data into a
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temporary file that the server can access. That temporary file only exists for the duration of the command
that required access to the file content. A sample script is included in the examples folder.

License Management Enhancements
License management has been enhanced in several ways in 7.0.1. The following sections describe how.
Note: If you are upgrading to 7.0.1 from a version older than 7.0, you will need to obtain a new license file
as we changed our license technology starting with version 7.0. See Get an AccuRev License on page 9 for
more information.

Master License Server
If you have multiple AccuRev master servers, one of those servers can be configured to be the master
license server, which serves licenses to all of the other master servers.
During a fresh 7.0.1 install or an upgrade to 7.0.1, the installer asks whether license information should be
obtained from a local license file or a remote license server. On the machine that is to be the master license
server, select the local license file option.
On the other master server machines, select the remote license server option. You will then be prompted to
enter the following values for the remote license server:
1. Host: The host name of the AccuRev master license server (which will serve licenses to the other master servers)
2. Port: The port that the master license server is configured to listen on (typically port 5050)
3. Username: The name of a user configured on the master license server. This username is used to verify that the local master server is authenticated and authorized to request licenses from the master
license server.
4. Password: The password for the Remote License User account on the master license server
Note: When one of the master servers is configured as the master license server, then all of the master
servers must be configured such that either:


SSL is enabled on the master license server and all the AccuRev master servers that obtain licenses
from it

or:


SSL is disabled on the master license server and all the AccuRev master servers that obtain licenses
from it.

Sharing Licenses Across Clients
Each master server uses its own pool of licenses, but within a single master server, licenses are shared by
user name. This means that if a single user logs into the same master server from many different clients, he
still consumes only a single license. However, if that same user logs into a different master server, a second
license is consumed for that second master server login.

Replica Server Installation
The installation process for a replica server no longer prompts for license information. Replica servers do
not need to be configured with licenses because they get their license information from the master server
they are replicating.
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User Account Credentials on Master License Server
If the user account credentials on the master license server are modified, the other master servers can be
updated via the maintain utility:


maintain setcnf REMOTE_LICENSE_USER <user_name>



maintain setcnf REMOTE_LICENSE_PASS <user_password>

These settings are stored in the acserver.cnf file on the local master server. The password is encrypted in
the same way as the DB_PASS password for accessing the PostgreSQL database.

“accurev licenses –fxv” Output
The output of the accurev licenses –fxv command has been enhanced in the following ways:


The last_renewed_time attribute in the user tag has been renamed to last_accessed_time for clarity.



A new host attribute in the user tag identifies the master server that the license was checked out for.



A new port attribute in the user tag identifies the port that the master server is listening on.



A new type attribute in the license tag distinguishes between “floating” and “named” licenses.
(Currently only floating licenses are sold.)

Here is an example of the enhanced output:
<acResponse>
<licenseCounts>
<license
name="AccuRev"
count="250"
usage_count="1"
type="floating"
min_checkout="1440"/>
<user
name="testuser1"
host="myhost"
port="5050"
checkout_time="2017/05/08 11:11:03"
last_accessed_time="2017/05/08 11:18:17"/>
</license>
</licenseCounts>
</acResponse>

Changes in AccuRev Release 7.0.1
AccuRev Release 7.0.1 includes the following new features and bug fixes.
Note: In cases where an issue is identified with two numbers, such as 10721 (1098410), the first
number is the issue number in the AccuWork issue tracking system, and the second, in parentheses, is
the issue number in the SupportLine system used by Customer Care.
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10721 (1098410) - GUI: User’s public queries are sometimes not displayed
In previous releases, saving one’s public queries could cause those queries to disappear from the display if
other users were also saving their public queries at the same time. This defect has been fixed in 7.0.1.
16371 (1097082) - GUI: Add ability to remove another user's workspace (already possible
on command line using rmws –s)
The GUI now provides the ability to remove another user’s workspace (by executing “Remove” in the
workspace’s context menu). The confirmation dialog identifies the user who owns the workspace.
27275, 41817 (1098163, 1098121) - GUI: Clicking a row in the Stream Browser search
results table does not locate stream in collapsed tree
Clicking on a row in the table of search results at the bottom of the Stream Browser view should locate and
select the corresponding stream in the graphical display in the top part of the Stream Browser view. Prior
to 7.0.1, this function did not work if the stream was located in a collapsed subtree of the stream hierarchy.
The 7.0.1 GUI correctly handles the situation by expanding the collapsed subtree and highlighting the
selected stream.
33724 (1094949) - GUI: The preferences.xml file may not be valid after an upgrade from 5.x
to 6.x, causing Save Layout to fail.
The upgrade from AccuRev 5.x to 6.x required that a user’s .accurev/preferences.xml file (found in the
$HOME or %ACCUREV_HOME% directory) be removed after the upgrade in order for the Save Layout
functionality to work properly in the 6.x GUI.
This problem does not exist for upgrades to Release 7.0.1.
36137 (1097059) - Tasks are not being completed due to locks on workspace files
In previous releases, a client command (update, stat) could become unresponsive if multiple commands
were running simultaneously in the same workspace. This was due to a contention problem within the
workspace’s local TSO database. These hung client commands would show up in the server tasks tab as
long running tasks. This issue has been fixed in 7.0.1.
36858 (1098352) - GUI: Cancelling the Required Fields dialog should result in no changes
to issue form
When a user saves an issue without providing values for some required fields, the GUI displays the
Required Fields dialog. In 7.0.1, the values entered in the Required Fields dialog are not written to the
issue form until the user clicks Save. That way, if the user clicks Cancel in the Required Fields dialog, the
issue form remains completely unchanged.
38631 (1100416) - GUI: Support change workspace functionality in Stream Browser
In the 7.0.1 GUI Stream Browser, the context menu for workspaces now includes “Edit”, which displays
the “Edit workspace” dialog.
38727 (1100721) - “accurev issuelist” result omits issues that have subtasks
In previous releases, the list of issues returned by the “accurev issuelist -s” CLI command omitted an issue
that was active in the stream if that issue had a subtask issue that was not complete in the stream. This
defect has been fixed in 7.0.1 – active issues are included in the result regardless of their subtask issues’
status.
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38927 (1101346) - GUI: Differentiate more clearly between Promote and Demote
In order to prevent accidental execution of the Demote command instead of the Promote command, the
7.0.1 GUI makes a clearer distinction between the two commands in these ways: (a) the buttons for
Promote and Demote are horizontally separated by a large space, and (b) in the context menu, Demote,
along with the Revert operations, have been moved into a submenu called “Undo Actions”.
38999 (1101615) - GUI unable to display issue history
In the past, the GUI was unable to display Issue History if an issue contained a field that (a) held a lot of
data (e.g., a very large body of text) and (b) had been modified many times. In 7.0.1 the method for
identifying modified fields has been streamlined and made more efficient. As a result, this GUI defect has
been resolved.
39425 (1102853) - AccuRev metadata backup doesn't include all stream favorites
information
Prior to 7.0.1, stream favorites information was stored in .sto files under the server’s <ac-install>/storage/
depots directory, and references to the .sto files were stored in the database. Consequently, restoring
AccuRev metadata did not restore the .sto files, and this caused the GUI to hang as it started up after a
restore. In 7.0.1, stream favorites information is stored in the database and is therefore restored along with
other metadata. During an upgrade to 7.0.1, the data in existing .sto files is copied into the database. (The
.sto files are not deleted during upgrade; they are left intact.)
41703, 41708 (1105061) - Many backed files shown with (external) status in Outgoing mode
of File Browser
Prior to 7.0, backed files were sometimes shown with (external) status in the GUI. This was caused by a
defect in the files CLI command. If an element argument to the command either started or ended with a
path separator (e.g., ‘/’), then AccuRev would sometimes incorrectly mark some elements as external.
This defect in the files command has been fixed in Release 7.0.1.
44085, 44287, 44674 (1097691) - Archive enhancements
AccuRev 7.0.1 includes several enhancements to the way that users can interact with files that have been
archived. These enhancements help to identify which files the user would benefit most from archiving,
and they provide a mechanism by which the AccuRev server can access files that have been archived.
See Archive Enhancements under What’s New in AccuRev Release 7.0.1 for more complete information.
44109 - GUI: Choose schema fields by label instead of name when creating a query
AccuRev’s web interface allows the user to select issue fields by label rather than by name when creating
or editing an issue query. As of 7.0.1, the GUI’s query editor does the same. This is especially useful to
users whose display language is something other than English (since the field labels are in English).
44111 - GUI: In Schema Editor, add ability to configure max number of displayed items in
List and Choose fields
It is now possible to configure the maximum number of rows displayed in the dropdown list for an issue
field of type List or Choose. The value is set in the “Number of Items Visible” field on the new Style subtab of the Schema Editor’s Schema tab. (If the number of items in the list exceeds the configured value, a
scrollbar is displayed with the dropdown list.)
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44112 - GUI/Web UI: Support line breaks in schema field labels
Long schema field labels are automatically wrapped when an issue is displayed in either the GUI or Web
UI. In 7.0.1 it is also possible to force a line break at a particular place in the label by inserting “\n” in the
text of the label.
44113 - GUI: Support Undo in text fields
Release 7.0.1 supports Undo functionality in text fields in the GUI.
44114 - GUI: Merge operation in issue change palette appears to succeed even though a
locked file prevents the merge from completing successfully
When a merge operation was executed from the issue change palette in previous releases, if a file lock
prevented the content of a file from being updated after the merge completed, the GUI still removed the
file’s (overlap) status and reported the merge operation as a success even though the file’s contents hadn’t
changed.
AccuRev 7.0.1 now treats this scenario as a failed merge, displaying appropriate error messages to the user
and displaying files in the issue change palette with their original, unchanged status. When multiple files
are being merged, the entire operation is treated as a single transaction. If the merge of one file fails due to
some error, then AccuRev halts the operation, undoes any merges that have already been completed, and
reports the merge operation as a failure. All the files are restored to their original contents and status.
44115 - Request localization and support of the AccuRev client on Mac OS in Japan
AccuRev 7.0.1 supports the “ja” locale on Mac OS.
44118, 44556 - GUI: Support styling of individual issue fields
Beginning with Release 7.0.1, it is possible to style the label and value of individual issue fields. Style
parameters can be configured in the new Style subtab of the Schema Editor’s Schema tab.
See Styling Individual Issue Fields in the Schema Editor under What’s New in AccuRev Release 7.0.1 for
more complete information.
44119 (1105115) - Web UI: Query browser’s “Set up Columns” dialog lists a maximum of
100 available columns
The Web UI’s query browser used to display only 100 items in the Available Columns list of the “Set up
Columns” dialog. This limit has been removed in Release 7.0.1.
44120 - Failed login attempts should be identified in acserver.log
In previous releases, acserver.log gave no clear indication of whether login attempts succeeded or failed.
Now each acserver.log login entry includes either “login_successful” or “login_failed”.
44121 - GUI: AccuWork “Save Attachment As” should request confirmation before
overwriting existing file
In the GUI, if the user attempts to save an AccuWork issue attachment to a path that already exists on the
client machine, AccuWork now displays a confirmation dialog instead of immediately overwriting the
existing file.
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44124 - GUI: Login dialog or warning message goes unnoticed because there is no
AccuRev icon in Windows taskbar
Prior to 7.0.1, the AccuRev icon did not appear in the Windows taskbar until the user was successfully
logged in to AccuRev. This made it difficult for users to find the AccuRev dialog if it was buried under
other windows on the desktop. In 7.0.1, the AccuRev icon appears in the Windows taskbar immediately
when the GUI is invoked.
44125, 44147 - Add client-side setting to use time basis to determine overlap status
The stat and merge CLI commands have a new option called “--use_time_basis_for_overlap”, which
instructs AccuRev to identify overlap using a workspace’s update level or a stream’s time basis instead of
using the current time. When this option is used, AccuRev shows (overlap) status for a file only if the file
was overlapped at the time indicated by the workspace's update level or the stream's time basis.
The GUI equivalent of the “--use_time_basis_for_overlap” option is a new preference called “Use Time
Basis For Overlap”, visible on the General tab of the AccuRev Preferences dialog. In addition, the File
Browser displays a new checkbox called “Use Time Basis For Overlap”. If the user changes the value of
the preference, the checkbox value is updated accordingly, and vice versa.
44126 - Define server-side USE_MOD_TIME setting to control default file timestamps
Earlier AccuRev releases support a client-side setting called ACCUREV_USE_MOD_TIME, which can
be set either as an environment variable or in the preferences.xml file in the user’s .accurev directory. A
value of 1 indicates that a file copied from the repository into a workspace by the AccuRev commands co,
pop, purge, revert, or update will have a timestamp equal to the original Keep time of the version in
AccuRev. If ACCUREV_USE_MOD_TIME is set to a value other than 1 on the client machine, the
timestamp of the file will indicate the time that the copy was created.
In addition to that client-side setting, AccuRev 7.0.1 also supports a new server-side setting called
USE_MOD_TIME, which can be set in the acserver.cnf file. If set to TRUE (case-insensitive), a file
copied from the repository into a workspace will have a timestamp equal to the version’s original Keep
time. If USE_MOD_TIME is set to any other value or is not set at all on the server, the timestamp of a file
copied into a workspace will indicate the time that the copy was created.
Important note: If ACCUREV_USE_MOD_TIME is set to any value on the client machine, that clientside value overrides the value of USE_MOD_TIME on the server. If ACCUREV_USE_MOD_TIME is
not set on the client machine, then the value of USE_MOD_TIME on the server is applied. If no variable
is set on the client or server, then the file timestamp will indicate the time that the copy was created.
44127 - GUI: Attaching a file to an issue and making a workflow transition without first
saving the issue causes the file to be saved as a link path
Prior to Release 6.2.2, attaching a file to an issue and then transitioning to another workflow stage without
first saving the issue resulted in AccuWork:


not attaching the file to the issue, and



displaying the local path of the file as the File Name in the Attachments table.

This problem has been resolved in 7.0.1.
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44128 - GUI: Add confirmation dialog to prevent accidental creation of parent-child issue
relationship
In earlier releases, users could unintentionally create a parent-child relationship between two issues by
dragging and dropping one record to another in AccuWork’s query result panel. Release 7.0.1 resolves this
problem by displaying a confirmation dialog before executing the operation.
44129 (1096645) - server_dispatch_post trigger not reporting all issues changed in bulk
update
In previous releases, when a bulk update in the Web UI fired the server_dispatch_post trigger, the resulting
email notification reported only one issue as having been changed. In Release 7.0.1, the email notification
now properly identifies all the issues that were modified by the trigger.
44130 - GUI: Add ability to use custom user properties (like Display Name) when exporting
query results to a CSV file
AccuRev 6.2.3 introduced the ability to display a custom user property instead of an AccuRev username in
a field of type User in an issue form; however, the AccuRev username was still displayed when editing
queries and viewing and exporting issue query results. With release 7.0.1, the configured custom user
property is used instead of the AccuRev username in all of these scenarios.
44132 - GUI: Impossible AccuWorkflow transition can be selected in pull-down menu
In this release, AccuWorkflow transitions that cannot be made from the current stage are greyed out and
disabled in the combobox that lists all the transitions.
44134 - GUI: Highlight lines related to selected version in Version Browser
In the Version Browser, all lines leading directly into the left side of the selected version are now drawn
with a heavier weight line (but still in the appropriate color) to make it easier to view relationships between
versions.
44135 - Support depot and stream names that start with a digit
Depot names and stream names may now contain a digit anywhere in the name, including at the beginning,
but the name must contain at least one non-digit character.
44136 - Web UI: Improve Issue Form Performance
In previous releases, issue form validation in the Web UI could take a long time (over five seconds) if the
issue schema contained many fields; this was especially true for the Microsoft Internet Explorer browsers.
The 7.0.1 Web UI has been modified to improve issue form validation performance. In many common
cases where validation used to take five seconds or more, the new Web UI has reduced that time to less
than a second.
44138 - GUI: Support pasting of multiple values into List Values or Field Values box of
Schema Editor
In the Schema Editor, it is now possible to paste a list of strings into the List Values or Field Values box for
a schema field of type List or Choose, respectively. If duplicate values exist, the user is notified via a
warning dialog, and the duplicate values are omitted from the schema field’s list of permissible values.
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44140 - GUI, Web UI: Display warning dialog when user inputs an unsupported character
When an invalid character is typed into an issue field, the AccuRev GUI and Web UI now display a
warning message in the status bar. The GUI also plays a beep sound.
44141 - GUI: Export attachment files with other issue data from query results table
In this release, if a user exports a query results table containing an Attachments column, the GUI will
prompt the user to enter an attachment archive file name. The GUI will save all files that are attached to
the exported issues in a zip archive file, with a separate directory for each exported issue.
44144 - GUI: Support forward slash character in List and Choose values in schema
It is now possible for configured values of Choose- and List-type schema fields to contain the following
characters: ‘/’, ‘&’, ‘>’, ‘<’, and ‘”’ (double quote).
44149 - maintain: discard regular streams and workspaces that have no version history
The new discard command in the maintain utility permanently deletes any type of stream (including
snapshot and workspace), provided that the following criteria are true:
5. The stream has no child streams.
6. If the stream ever had any child streams, all of those child streams have already been discarded.
7. No other streams have cross-links into the stream.
8. No versions were ever kept in or promoted to the stream.
9. The stream is not the most recently created stream on the system.
If any of these criteria are not satisfied, the discard will fail.
Once discard deletes a stream, it is not possible to reactivate the stream. However, it is possible to create
a new stream that has the same name as the discarded stream.
44157 - Core: Add ability to lock users after “N” number of failed logins
The new trigger server_login_trig gives AccuRev administrators the ability to lock out users after a
certain number of failed login attempts. A sample script is included in the examples folder.
44158 - GUI: Make bulk merge work for StarTeam merge
The StarTeam merge tool now works properly in bulk merge mode. That is, if the user elects to auto-keep
trivial merges, the StarTeam merge tool appears only for files that have non-trivial (i.e., conflicting)
changes.
44419, 45211 - Create wizard to update a stream after a time basis change
The “Sync Stream wizard” introduced in the 7.0.1 GUI syncs a stream with its backing stream by running
rebase and merge operations. The wizard is invoked automatically when the user changes a stream’s time
basis. It can also be invoked manually on any stream by clicking the Sync button in the File Browser view.
See Sync Stream Wizard in the GUI under What’s New in AccuRev Release 7.0.1 for more complete
information.
44443 - GUI Version Browser: Show the promotion path leading to a version
The GUI Version Browser has a new context menu item called “Show Promotion Path” for versions that
were created by a Promote or Demote operation. Show Promotion Path displays a solid orange line to
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trace the sequence of promotions and demotions leading from a real (kept) version all the way to the
selected virtual version. This path helps the user visualize the flow of changes in the system.
The user can clear the promotion path from the display by taking any of the following actions:


clicking Refresh View



changing the transaction range



executing Show Ancestry



clicking on a different stream in the bottom panel of the version browser

See Version Browser: Highlighted Version Relationships and Show Promotion Path under What’s New in
AccuRev Release 7.0.1 for more complete information.
44906 - Remove restrictions about Japanese characters in stream names in Japanese
locale
Release 7.0.1 supports the use of Japanese characters in stream names and depot names.
45756 (1108535, 1109132) - GUI: Promote from workspace to backing stream fails after
backing stream has been renamed
In previous releases, promoting a file from a workspace to its backing stream would fail if the backing
stream had been renamed. (Doing the promotion from the command line would succeed, however.) This
defect in the GUI has been fixed in Release 7.0.1.

Corrections and Changes to the Documentation
Please note the following corrections and changes to the AccuRev 7.0.1 documentation:
37526 (1100041) - DOC: “Enabling the Client Upgrade feature” in Installation and Release
Notes does not cover Mac OS X, Solaris, HP
The Installation and Release Notes section on “Enabling the Client Upgrade feature” has been updated to
address Windows, Linux, Solaris, AIX, and Mac OS X platforms. 7.0.1 does not support the HP platform.

Known Issues
This section describes known issues in AccuRev and in the AccuRev Web UI.
The GUI and Web UI for older AccuRev releases don’t support later schema
enhancements
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If the schema contains (or ever contained) any fields of type Group, issue creation and editing
must be done using the GUI or Web UI of Release 6.2.3 or later. A schema containing Group-type
fields is incompatible with releases prior to 6.2.3.



(minor) The Display Property for User-type issue fields is ignored in the GUI or Web UI of any
pre-6.2.3 release. The AccuRev username is displayed instead of the configured Display Property.
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(minor) Styling of individual issue fields is ignored in the GUI of releases older than 7.0.1.



(minor) The “\n” newline notation in a field label is displayed as the string “\n” instead of as a
newline in the GUI and Web UI of releases older than 7.0.1.

Context-sensitive help does not open on CentOS 6 machine
On a CentOS 6 machine (client or full install), clicking the "?" icon or the Help => Help menu item
has no effect; context-sensitive help information is not displayed. (CentOS6 uses Gnome 2.28.2.)
Settings on the machine are as follows:


the default web browser in the desktop environment is set to Firefox:
[auser@localhost bin]$ xdg-settings --list
Known properties:
default-web-browser

Default web browser

[auser@localhost bin]$ xdg-settings get default-web-browser
firefox.desktop



Online Help Browser is set to "<Default Browser>" in the GUI’s AccuRev Preferences dialog.

If Online Help Browser is set to "firefox" instead, then context-sensitive help gets displayed properly.
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AccuRev 7.0 Release Notes
This chapter describes changes and other information related to AccuRev 7.0.
Note: To ensure optimal performance, install all applicable updates for your operating system.

Changes in AccuRev Release 7.0
AccuRev Release 7.0 includes the following new features and bug fixes.
Note: In cases where an issue is identified with two numbers, such as 26649 (1094789), the first
number is the issue number in the AccuWork issue tracking system, and the second, in parentheses, is
the issue number in the SupportLine system used by Customer Care.

New License Manager
In AccuRev 7.0 the Reprise RLM license manager has been replaced with a new built-in license manager,
which supports standard and flexible licenses. In order to upgrade to AccuRev 7.0, you must first obtain a
new license file named aclicense.txt. For instructions on that procedure, see Get an AccuRev License on
page 16.
See the AccuRev Administrator’s Guide for a full description of license management in AccuRev 7.0.
24355 (609971) -- CLI: Hist command does not show filename that was 'removed' from the
issue
Output from the Hist command now includes the names of files that have been removed from an issue.
26649 (1094789) -- GUI: In the Schema Editor, removing a field can result in an invalid
logic.xml file
Previously, the GUI would sometimes behave erratically in the Queries tab if a schema field had been
manually deleted from the schema.xml file. (Manual changes to any of the AccuRev schema files are
highly discouraged.) With this release, the GUI instead writes an error log message to the GUI log and
ignores any references to the manually deleted field.
33753 (1102274) -- xlink on xlink fails if both are snapshots
Previously, when displaying the elements in a directory cross-linked to another cross-linked directory,
where both are snapshots, the status of the elements was displayed as "no such element". With this release,
the correct status of those elements is displayed.
34936 (1095751) -- RFE: Request for way to disable Admin Menu button on Web GUI
toolbar
One can now hide the “Admin” menu in the WebUI toolbar by adding a “disableAdmin” tag inside the
“security” tag in the wui_config.xml file and then restarting Tomcat. An example of the new
“disableAdmin” tag:
<security>
<userName minLength = "0" minDigitCount = "0" minLetterCount = "0"/>
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<password minLength = "0" minDigitCount = "0" minLetterCount = "0"/>
<disableAdmin>true</disableAdmin>
</security>

35176 (1096053) -- RFE: Use stream names in the WebUI rather than stream numbers
The WebUI issue form now displays stream names instead of stream numbers in the Version and Basis
Version columns of the Changes tab.
35350 (1096166) -- RFE: Ability to add a user to multiple groups via a single CLI command
The CLI "addmember" command now supports adding a member to multiple groups. The group names
must be specified in a comma-separated list that is the last argument of the command.
35818 (1096586) -- GUI: AccuWork query for dates has issues when comparing against
current date
Previously, for a Timestamp-type field with a granularity of days, an “is before or equal to” comparison of
the field against “CUR_DATE” would not yield the proper results. With this release, the comparison is
done correctly.
35839 (1096610) -- GUI: Pasting text into a rich text field in AccuWork destroys existing
layout of the field being pasted into
A new WYSIWYG editor has been introduced in AccuRev 7.0. Pasting text into a rich text field no longer
inserts extra line breaks into the text.
37473 (1099867) -- GUI: Pasting text that starts with a slash '/' fails in text and log fields
A new WYSIWYG editor has been introduced in AccuRev 7.0. Pasting in text that starts with a slash
causes no problems.
39139 (1101999) -- Correct directory element not showing after defuncting evil twin
directory
Previously, after defuncting an evil twin directory and promoting it to the backing stream, the backing
stream's Stream Explorer still showed the defuncted directory element, with a status of "(twin)(member)".
With this release, the Stream Explorer shows the directory element that was not defuncted.
39235 (1102322) -- GUI: Version Browser displays the wrong issue number
Previously, under certain circumstances, the Version Browser would display only the last few digits of an
issue number associated with a version. With this release, the full issue number is always displayed.
39250 (1102389) -- GUI: Diff Prev Trans opens diff with wrong version
Previously, executing "Diff Prev Trans." on the first version of a file in a stream would sometimes bring up
a Diff window comparing that first version with another version of the file. With this release, that
operation will result in a dialog window saying "Previous transaction cannot be found for selected
version."
39540 (1103182) -- User did a revert on a link from a replica and it crashed the server
The server used to crash if this sequence of operations was executed: Link to a file (via “accurev ln”),
promote, change the link to point to a different file, promote the link again, then revert the last promote in
the backing stream. With this release, the Revert operation executes successfully.
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39568 (1103306) -- AccuRev is reporting a protocol mismatch when client runs out of disk
space
The error message has been improved. It now reads:
"A problem occurred writing to the file system. There is not enough space on the disk."
41134 (609864) -- RFE: Request to have timestamps in Postgres log by default
A timestamp is now added to each record in the postgresql*.log file.
41140 (1095548) -- RFE: Stream Favorites search should be case-insensitive
The Create/Edit Stream Favorite dialogs and the Find dialog in the Stream Browser now have a "CaseSensitive" checkbox that controls whether searches are case-sensitive or case-insensitive. The setting of
this checkbox is sticky, and it is shared across the Create, Edit, and Find dialogs.
41161 (1104364) -- RFE: Request to be able to view and interact with issue 0
AccuRev 6.x removed the ability for users to view and to promote changes against issue 0. AccuRev 7.0
restores the ability to promote changes against issue 0, either from the command line or in the GUI, as a
way of indicating that the changes are not associated with any issue. It is not possible to view issue 0 in
AccuRev 7.0.
41231, 43104 (1104539) -- RFE: Stream history menu option to use time model in addition
to transactions
Previously, the History Browser's "Show:" menu listed options for 20 transactions, 50 transactions, 100
transactions, and "Everything". AccuRev 7.0 supports additional options -- 1 month, 3 months, and 6
months -- allowing the user to specify the amount of history to see as a number of months.
41266 (1103111) -- RFE: Upgrade tomcat used by WUI (to Tomcat 8.0.33)
The AccuRev 7.0 WebUI is installed with and runs on Tomcat 8.0.33.
41799 (1100524) -- Values are not populated to trigger parameter file for Revert action
For the Revert operation, the stream name and change package ID are now passed in the trigger parameter
file so that they are available to the trigger.
41802 (1096649) -- CLI: anc -1 -v returns an invalid version number
Previously, if the command “anc -1 -v” was executed for the first version of a file in a stream, an invalid
version number would be returned. With this release, the correct answer of “0/0” is returned.
41807 (1102080) -- RFE: lsrules '-fmx' option to be used with -d command option
The "lsrules" command now supports the use of the "-d" option with the "-fmx" option to list only the rules
that were explicitly set for the workspace (or stream), excluding rules that are inherited from higher-level
streams.
41812 (1101574) -- RFE: Ability to use more than one type when using the -k switch with
the hist command
The CLI "hist" command now supports specifying multiple types of transactions. The transaction types
must be specified in a comma-separated list after the "-k" option flag.
41814 (1102504) -- GUI: Search button not active on Find box
Pasting text into the Stream Browser's Find text box now enables the Search button properly.
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41816 (1103844) -- RFE: Annotate from Active Transaction/History view in GUI
The Annotate command has been added to the context menu of the Versions pane (the lower pane) in the
History Browser.
41903 (621027) -- GUI: No label on CPK Dialog Box for Issue field
In the "Send to Issue" operation, the issue number field in the "Select Issue (Change Package)" dialog used
to be unlabeled. Now the field is labeled "Issue:".
43422 (1106840) -- Core: show streams performance issue because of extended backing
stream info on passthrough streams
The performance problem has been resolved. The "show streams" command now builds stream hierarchy
information only for the Demote operation, which requires that information.
43895 (1107122) -- GUI: Remove logback.xml from fw.jar
The logback.xml file has been removed from the fw.jar file and is now installed directly in the
<ac_install>/bin/ directory.

Corrections and Changes to the Documentation
Please note the following corrections and changes to the AccuRev 7.0 documentation.
25496, 43031 (1100525) -- DOC: Trigger documentation needs improvement
Appendix B, "Trigger Commands and Parameters", has been added to the Administrator's Guide. It lists
the parameters that are passed to trig_server_all and trig_server_preop for each command.
36259 (1097551) -- DOC: hist option -f3 missing from the hist man page
The Help page for the "hist" CLI command now describes the -f3 option.
37124 (1103084) -- DOC: Add documentation about the ability to set max size of files within
AccuRev
In the 7.0 Administrator's Guide, the section called "Server-Side Triggers" describes the ability to enforce
a maximum file size for the "add" and "keep" commands. An example is provided in the
server_preop_trig.pl sample file, which is installed in the AccuRev examples folder. The sample trigger
file defines a maximum file size and compares that to the file sizes that AccuRev passes in as parameters to
the trigger file.
39773 (1103740) -- DOC: CLI - mkuser doc page is missing GitCentric in the "Description"
field for a “full” license
The mkuser doc page has been corrected.
39797 (1103792) -- DOC: 6.2.2 client install fails with "api-ms-win-crt-runtime-I1-1-0.dll is
missing" error
The System Requirements have been amended to state that Windows 7 SP1 is required. SP1 resolves the
missing dll error.
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42016 (1105390) -- DOC: Document support for custom user properties that was
introduced in 6.2.3
Discussion of custom user properties and other enhanced user management features (group-type issue
fields, new validation actions, forward matching) has been added to these sections of the documentation:
- "setproperty" in the CLI User's Guide
- "The History Browser" in On-Line Help
- "Schema Tab" in The Schema Editor
- "Validation Tab" in The Schema Editor
- "Working with Issues" and "Issue Form" in AccuWork

Known Issues
This section describes known issues in AccuRev and in the AccuRev Web UI.

Known Issues in AccuRev
GitCentric server is incompatible with AccuRev 7.0
GitCentric releases from 2015 and earlier are not compatible with AccuRev 7.0. An upcoming release
of GitCentric will resolve the incompatibility. If you have GitCentric Server, we recommend that you
wait for the next release of GitCentric before you install AccuRev 7.0.
Upgrade install ignores user-entered configuration information
During an upgrade install (i.e., an install on top of an existing AccuRev bin directory), the installer
prompts the user to enter the same configuration information that it asks for during a fresh (nonupgrade) install. However, for an upgrade install, the information entered by the user is actually
ignored, and the installer instead uses the values that are already stored in the <ac_install>/bin/
acserver.cnf file.
Cannot upgrade AccuRev client on macOS
macOS: Because the package name for the client installer has changed from AccuRev to
AccuRevClient in 7.0, there is no way to upgrade earlier macOS clients. Uninstall the previous client
(or simply discard the Applications/AccuRev directory) and do a fresh install of AccuRevClient 7.0.
No master license server in AccuRev 7.0
AccuRev 7.0 has replaced the standalone Reprise License Manager (RLM) with a new license
manager directly built into the AccuRev server. A side effect of this change is that each master
AccuRev server now needs to be issued its own license file.* The issue of a master license server will
be addressed in a future release of AccuRev.
*(Replica servers do not need their own license files; they get licenses from their master servers.)

Issues synced to JIRA show HTML formatting tags in rich text issue fields
Because of the new rich text editor control used in AccuRev 7.0, rich text issue fields that are edited in
AccuWork display HTML formatting tags in JIRA after the issue is synced to JIRA. If users
commonly use JIRA to edit issues, the impact is minimal. However, if users mostly use AccuWork to
edit issues, we recommend upgrading to AccuSync 2016.2 in order to reduce the number of tags that
are visible in JIRA.
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Issuelist incorrectly marks an issue as incomplete if a defuncted element was promoted to
the backing stream
The “issuelist” command incorrectly marks an issue as incomplete if all of the following are true:
1. The stream hierarchy has cross-links in it
2. The issue contains a defuncted element that has been promoted to the current stream’s backing
stream
3. Other changes for the issue are still active in the current stream
In this scenario, the defuncted element is incorrectly labeled as "missing".
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